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AccelSoft Inc. Software License Agreement, PowerTraceª for the Single-Computer/Single-User

CAREFULLY READ ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT BEFORE
OPENING THIS PACKAGE.  IF THESE TERMS AND CONDITIONS ARE NOT ACCEPTABLE TO
YOU, PROMPTLY RETURN THIS PACKAGE AND ALL OTHER COMPONENTS OF THIS
SOFTWARE PRODUCT TO THE PLACE OF PURCHASE FOR A REFUND.  OPENING THIS
PACKAGE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS.

LICENSE. AccelSoft Inc. grants you a license to use the PowerTrace computer program (ÒProgramÓ),
recorded on the original diskettes, on one single-user computer.  You may physically transfer the
Program from one single-user computer to another single-user computer as long as you use the Program on
only one single-user computer at a time.  You may not (a) use the Program on a multiple-user computer or
a network of single-user or multiple-user computers, (b) electronically transmit the Program over a
network of single-user or multiple-user computers, (c) rent or lease the Program to others, or (d) reverse
engineer, decompile or disassemble the Program.

OWNERSHIP. Your license is not a sale of the Program.  AccelSoft Inc. retains title to the PowerTrace
computer program. You only acquire title to the original diskettes used to distribute the Program.

COPYRIGHT. The Program is protected by United States copyright laws and international copyright
treaties.  You may (a) copy the Program onto other diskettes solely for archival or backup purposes or
(b) copy the Program onto a single hard disk and retain the copy of the Program on the original
diskettes solely for archival or backup purposes.  You must retain all copyright notices for the Program
on all copies of the Program.  You may not make any other copies of the Program except as provided
herein.

ASSIGNMENT. You may assign your license to another person if that person agrees to the terms and
conditions of this Agreement.  You must physically transfer  the Program to that person and destroy any
and all copies of the Program which you do not physcially transfer to that person.

DURATION. Your license is effective for an indefinite term unless you fail to comply with a term or
condition of this Agreement.  If you fail to comply with a term or condition of this Agreement, your
license automatically terminates and you must destroy your copies of the Program.

LIMITED WARRANTY. AccelSoft Inc. warrants that the original diskettes are free of defects in
materials and workmanship.  If you discover a defect and return the original diskettes to the place of
purchase within ninety (90) days after the date of your purchase, the original diskettes will be
replaced without any additional charge.  THIS LIMITED WARRANTY REPLACES ALL OTHER
WARRANTIES EXPRESS OR IMPLIED, INCLUDING WARRANTIES OF MERCHANTABILITY OR
FITNESS OR A PARTICULAR PURPOSE.  SOME STATES DO NOT ALLOW THE EXCLUSION OF
IMPLIED WARRANTIES SO THESE EXCLUSIONS MAY NOT APPLY TO YOU.  THIS LIMITED
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.  YOU MAY ALSO HAVE OTHER RIGHTS
WHICH VARY FROM STATE TO STATE.

LIMITATION OF LIABILITY. ACCELSOFT INC. SHALL NOT BE LIABLE FOR ANY DAMAGES,
INCLUDING INCIDENTAL OR CONSEQUENTIAL DAMAGES, ARISING FROM USE OF THE
PROGRAM. SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY
FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION MAY NOT APPLY
TO YOU.

GENERAL. This Agreement contains the entire understanding of the parties and supersedes all prior
communications, proposals, agreements, and contracts and purchase orders pertaining to the Program.

AccelSoft Inc. is a subsidiary of G. H. Gillespie Associates, Inc.

AccelSoft Inc.
P.O. Box 2813, Del Mar, CA 92014, (858) 677-0133
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I agree to the terms and conditions of the AccelSoft Inc. Software License Agreement as stated on
the preceding page.

                                                                      
Signature Date

                                                                                                                                    
Printed Name Organization

                                                                                                                                           
Street Address

                                                                                                                      
City State or Province Postal Code

                                                    
Country
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1.  Introduction

PowerTrace is a graphical user interface shell which has been integrated to run
with the accelerator beam dynamics code TRACE 3-D.  The interface is based on
the Shell for Particle Accelerator Related Codes (S.P.A.R.C.) software
technology.  This manual describes the operation and use of the PowerTrace
interface with the TRACE 3-D program.

TRACE 3-D is a FORTRAN program maintained and distributed by the Los
Alamos Accelerator Code Group.  TRACE 3-D is integrated with the
PowerTrace  software under a license agreement with the Los Alamos National
Laboratory and the Regents of the University of California.  A copy of the
TRACE 3-D Documentation is included at the end of this manual and distributed
with PowerTrace under the same license agreement.
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PowerTrace Overview
PowerTrace is a Graphic User Interface (GUI)
developed to work in conjunction with the TRACE 3-D
program on PowerPCs under the Mac OS.  Sections 2-3
of this User Manual describe the use of the PowerTrace
GUI.  Section 4 discusses the various matching options
available in TRACE  3-D and Section 5 describes the
PowerTrace commands used to run TRACE  3-D.
Section 6 discusses User Preferences.  Section 7
describes Customization of the PowerTrace application.
Documentation for the TRACE  3-D program is
included as an appendix to this User Manual.
PowerTrace is based on the Shell for Particle
Accelerator Related Codes (S.P.A.R.C.) software
technology which provides a graphic interface
customized to work with programs used for the design
and analysis of particle optics systems and accelerators.  

The PowerTrace software is distributed in both
Standard and Professional packages. The Standard
package contains the PowerTrace application only,
while the Professional package includes the S.P.A.R.C.
object code for the PowerTrace GUI and the
TRACE 3-D FORTRAN source code used to build the
P o w e r T r a c e a p p l i c a t i o n f o r t h e P o w e r M a c .
Professional users can compile and link a customized
version of TRACE 3-D using templates provided for
FORTRAN subroutines that are accessed through the
GUI as Custom elements on the Palette Bar.

Several Custom elements that are not part of the
original TRACE 3-D program have been developed and
are also available as plug-in modules.  The FORTRAN
source code is also included with these modules.  

The Electrostatic Palette provides a set of elements for a
variety of electrostatic lenses and accelerator columns
that have been developed including three einzel lenses,
two electrostatic accelerating columns and three
electrostatic prisms.  These elements utilize the first-
order R matrix formalism to compute changes to the
beam  (Sigma matrix), calculating the effective  transfer

PowerTrace is a custom
graphic user interface
designed to work with the
beam dynamics program
TRACE 3-D.  PowerTrace
is fully integrated with the
TRACE 3-D program and
provides an easy to use
standalone package on the
PowerMac.

Professional users can
compile and link a
customized version of
TRACE 3-D.

The Electrostatic Palette
p r o v i d e s a d d i t i o n a l
C u s t o m e l e m e n t s t o
model electrostatic lenses
and accelerator columns.
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matrix in a series of longitudinal steps through the
element, incorporating changes in the Beam Energy as a
function of position in the electrostatic elements, as well
as calculating fringe fields and retaining the space
charge model for all elements.

A Traveling Wave Palette is also available for
PowerTrace users who want to use TRACE 3-D for
modeling traveling wave accelerators.  This palette has
been developed to allow incorporation of particle beam
loading (current) effects on the accelerator gradient and
the accelerator structure’s beam focusing properties in a
self-consistent manner.

TRACE 3-D Overview

TRACE 3-D is a FORTRAN beam dynamics program
maintained and distributed by the Los Alamos
Accelerator Code Group.  TRACE 3-D calculates the
envelopes and phase-space ellipses of a bunched beam,
including linear space-charge forces, through a
beamline.  TRACE 3-D also supports fourteen different
types of fitting or beam-matching options.  Matching
options will vary the Initial Beam parameters for a
matched beam in X,Y planes, Z plane, X,Y,Z planes
(Upright) or in X,Y,Z planes.  Fitting options will vary
element parameters to fit a desired beam in X, in Y, or
in the Z plane, in X,Y planes or in X,Y,Z planes.  The
Initial Beam can also be fit for a desired beam in X,Y,Z
planes.  In addition, TRACE 3-D can vary element
parameters to fit desired R-Matrix or σ-Matrix
elements, vary element parameters to fit for a round
beam, or to fit for specified phase advances in selected
phase planes.

T h e T r a v e l i n g W a v e
Palette provides additional
C u s t o m e l e m e n t s t o
model traveling w a v e
accelerators.

The TRACE 3-D program
calculates beam envelopes
and phase-space ellipses in
t h e t r a n s v e r s e a n d
longitudinal dimensions.
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2. Quick Start

This section is intended to provide users, who are familiar with both TRACE 3-
D and the Macintosh operating system, with a brief introduction to PowerTrace
that will get them up and running quickly.  Not all features of the PowerTrace
user interface are covered here and all users should (eventually) read the
complete User Manual and TRACE 3-D Documentation.
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Installing PowerTrace

The PowerTrace software is distributed in both
Standard and Professional packages.  The Standard
PowerTrace package contains the application and some
example beamline models.  The Professional package
also includes the S.P.A.R.C. object code for the
PowerTrace GUI and the TRACE 3-D FORTRAN
source code used to build the PowerTrace application
for the PowerMac.  Installation for the Professional
package is discussed in Appendix B “Customizing
PowerTrace”.

The PowerTrace application disk contains the
PowerTrace application and some example files, as
illustrated in Figure 2-1.  

Figure 2-1.  PowerTrace Application Disk.

The PowerTrace application requires no special
installation, simply insert the application disk into your
computer’s floppy disk drive and drag the contents to
your hard drive.  The application requires
approximately 1 MB of disk space.

T h e P o w e r T r a c e
application requires no
special installation, simply
drag the contents of the
application disk to your
hard drive.
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PowerTrace User Interface

The PowerTrace application may be opened by double
clicking the application icon or on a PowerTrace Model
file.  Figure 2-2 below illustrates the principal parts of
the PowerTrace application: the Menu Bar, Palette Bar
and the different panes of the Document Window (the
Global Parameter Pane, the Model Space Pane and the
Work Space Pane), as well as the TRACE 3-D Graphic
Output Window and Text Output Window.  Figure 2-2
indicates the principal parts of the PowerTrace
application with the “Example B” Model file which is
distributed on the application disk.

Build a beamline model by
Selecting Elements from
Palette Bar and Dragging
them to the Model Space
Pane of the Document
Window.

Pieces on the Work Space Pane

Beamline model in the Model Space Pane

TRACE 3-D Graphic 
Output Window

TRACE 3-D Text
Output Window

Editable Text Window 

Menu Bar Document Window

Global 
Parameter Pane

Drag Pieces from Palette Bar 
to Build a Beamline Model

Figure 2-2  PowerTrace Screen Shot.
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Running TRACE 3-D using PowerTrace is simple.  A
beamline model is defined by selecting elements from
the Palette Bar and dragging them to the Model Space
Pane of the Document Window.  As many as six
Document Windows may be opened at any one time.
PowerTrace windows may be expanded horizontally
and vertically, for example, to fit the size of the
monitor you are using, so the screen may appear
different than that shown in Figure 2-2.  The Palette
Bar will automatically expand to the height of your
monitor.  The output windows use a default size and
placement.  When resized and left open these windows
will scale the output for the new size on the next
execution of a TRACE 3-D command. 

Input Parameters

PowerTrace uses four sets of input parameters.  The
user inputs are grouped by: 

(1) Global Parameters, 
(2) Piece Parameters, 
(3) Matching Parameters and 
(4) User Preferences.

Global Parameters

The Global Parameters are set in the scrollable Global
Parameter Pane of each Document Window as
illustrated in Figure 2-3.  The Global Parameter Pane
contains input parameters which are global to the
beamline model such as the Particle Charge, Particle
Mass, Beam Energy, Beam Current and Frequency, etc.
Various unit options are available for several of the
Global Parameters.  Figure 2-3 illustrates the pop-up
menu for inputting the Beam Energy in terms of the
equivalent momentum units (in GeV/c).

The first step in building a
P o w e r T r a c e b e a m l i n e
model is to review the
Global Parameters and
m a k e c h a n g e s a s
necessary.
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Use this Scroll Bar 
to Access all of the 
Global Parameters 

as shown here

Several Different Unit 
Options are available 
for Input Parameters

Set all of the Global 
Parameters in the Global 
Parameters Pane of the 

Document Window

e V

keV

M e V

GeV

ß = ( v / c )

Gamma

p ( G e V / c )

Figure 2-3.  PowerTrace Global Parameter Pane.

Table 2-1 lists the ten Global Parameters of
PowerTrace and the corresponding TRACE 3-D
parameters.  

Table 2-1.  PowerTrace Global Parameters

# Power Trace Global Parameters TRACE 3-D
1 Particle Charge Q
2 Particle Mass ER
3 Beam Energy W
4 Beam Current XI
5 Frequency FREQ
6 PMQ Fringe Field Extension Factor PQEXT
7 Chromatic Aberrations ICHROM
8 Maximum Step Size SMAX
9 PMQ Max Step Size PQSMAX
10 Initial Beam Setup IBS

F o r d e f i n i t i o n s a n d
d i s c u s s i o n r e f e r t o
subheadings 9.1 and 9.3
from Section 9 “Input
Variables”, of the TRACE
3-D Documentation.
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Piece Parameters

The Piece Parameters define all of the elements in the
beamline model including the initial beam emittances
and Twiss parameters, and the final beam Twiss
parameters.  Double clicking on an individual piece in
the beamline model, such as the “Initial” Emittance
Piece in Figure 2-4, opens a Piece Window.  All of the
Piece Parameters for each of the beamline elements are
input through Piece Windows of this type.

Double Click Piece Icon to 
Open the Piece Window

Figure 2-4.  Initial Emittance Piece Window.

The Initial Emittance Piece Window is used to input
Initial Emittances (Emit) and Twiss Parameters (alpha
& beta) for the Horizontal (h), Vertical (v) and
Longitudinal (z) Planes.  Both the Initial and Final
elements are required in the beamline model to run
TRACE 3-D.  The BEAMI(6) and EMITI(3) data arrays
are filled with the values from the Initial Emittance
Piece parameters.

Refer to subheading 9.2
from Section 9 “Input
Variables”, of the TRACE
3-D Documentation.
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Input Parameters for Selected Beamline 
Element.  This Example Sets the Values 

for A(I,4)  where  I=1 to 5

Type Codes for the Elements 
are Automatically Set.  This 

Example Sets NT(4)=3 

Each Piece has a Self Explanatory 
Piece Window for Inputting 

Element Parameters 

Double Click Piece Icon to 
Open the Piece Window

Figure 2-5.  Example of a Piece Parameter Window

Figure 2-5 shows an example of a typical PowerTrace
Piece Window.  There are defaults values set for every
p a r a m e t e r . T h e a r r a y s N T ( N E L M A X ) a n d
A(5,NELMAX) are defined when each Piece icon is
dragged to the Model Space Pane, and the defaults are
used to initially fill in the values for these arrays.
Entering data in a Piece Window writes over the
existing entry.   The TRACE 3-D control parameters
N 1 and N 2 are defined by the location of the “Initial”
and “Final” Piece Icons in the PowerTrace beamline
model.  Once the Piece Parameters are input for all the
elements of the desired beamline, including the Initial
Emittance and Final Emittance parameters, then the
PowerTrace beamline model is “complete” and you are
ready to run TRACE 3-D commands such as “Graph”.  

Refer to subheadings 9.1
and 9.3 from Section 9
“Input Variables”, of the
T R A C E 3 - D
Documentation.
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Matching Parameters

The matching capabilities of TRACE 3-D are among it’s
most useful features, and there are several different
types of matching calculations possible.  Each  type of
matching calculation in PowerTrace uses a unique and
intuitive way to set up the problem.  For example the
“Final” Piece icon is also used to set the final Twiss
Parameters BEAMF(6) for matching types 5-8 and 13.
A complete discussion of PowerTrace matching is
beyond the intent of this Quick Start Section and is
covered in detail in Section 4 “Matching Options”.

User Preferences

The TRACE 3-D control parameters NEL1, NEL2, NP1
and NP2 are really User Preferences for controlling the
display of output.  PowerTrace sets default values for
these parameters automatically.  This automatic feature
may be turned off in the Options dialog which is
accessed from the Preferences Menu.  The values may
then be set explicitly in the Plot Control window, also
accessed from the Preferences Menu.  See Section 6
“User Preferences” for a complete discussion of all the
PowerTrace User Preferences and Options.

Running TRACE 3-D 

The TRACE 3-D program is executed using a variety of
commands in the PowerTrace Commands Menu
illustrated in Figure 2-6.  Most of the commands call
the TRACE 3-D FORTRAN and correspond directly to
the native TRACE 3-D commands defined in the
TRACE  3-D Documentation.  Many of the keyboard
equivalents have been retained.  For example,  “Graph”
is executed either by selecting the Graph Beam Line
command or entering -G from the keyboard (press
“G” while pressing the apple command “ ” key).  Some
keyboard equivalents require the command and option
keys to be pressed along with the TRACE 3-D
equivalent.  Figure 2-6 shows all of the PowerTrace
commands and corresponding TRACE 3-D commands.

Refer to subheading 9.4
from Section 9 “Input
Variables”, of the TRACE
3-D Documentation.

Refer to subheading 9.3
from Section 9 “Input
Variables”, of the TRACE
3-D Documentation.

Refer to Section 10
“ D e s c r i p t i o n o f
C o m m a n d s ” , o f t h e
T R A C E 3 - D
Documentation.
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PowerTrace commands are organized in four functional
groups.  The first group contains the standard
commands for executing TRACE 3-D.  The second
group of commands are for matching operations.  The
third group contains data display commands and the last
group includes some PowerTrace specific commands
and miscellaneous TRACE 3-D commands.  

Commands
Graph Beam Line
Trace on Background
Find Ellipses from Profile
Plot Projections
Calculate Phase Advance
Exchange Beams
Calculate Mismatch

Perform Matching
Match Without Print
Match in Range (MT=7,8,9)
Show Match/Couple
Show Match Variables
Restore Prematch Variables

Show Beam Vectors
Show R Matrix
Show Modified Sigma
Show Phase & Energy
Show TRACE 3D Data

Load Return Data (31->30)
PARMILA Units
Help
Reinitialize TRACE 3D

G
T
L
J
F
Å
¿

M
N
U

Ã

B
R
Z
·
¹

�

E

(   -Option-X)

(   -Option-V)

(   -Option-W)
(   -Option-P)

(   -Option-K)

(   -Option-O)

G             GRAPH
T              TRACE
L              ELLIPSE
J               PROJECTIONS
F              PHASE
X             EXCHANGE
O             MISMATCH

M             MATCH
N             MATCH
U             USER

V             VARIABLES

B             BEAM
R             R-MATRIX
Z             SIGMA

C             CONVERT

TRACE 3-D
     Code

PowerTrace
 Command

W             φ-W

   PowerTrace 
Key-Equivalent

TRACE 3-D
 Command

!              UNMATCH

-

-
-

-

P             PRINT

Figure 2-6.  PowerTrace Commands Menu.

Most of the PowerTrace
C o m m a n d s c o r r e s p o n d
directly to the native
TRACE 3-D commands
described in Section 10 of
t h e T R A C E 3 - D
Documentation.

This Quick Start Section of the User Manual is only
intended to provide a brief overview of the PowerTrace
application.  The remainder of the User Manual
provides more information on the material presented in
the Quick Start Section, as well as other important
subjects on the use of the PowerTrace application.  All
users are encouraged to read the entire User Manual.
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3.  PowerTrace Interface

This section provides a description of the PowerTrace user interface and defines
terms used to refer to different parts of the interface.  It also provides an
overview of the data structures and the transfer of data between the interface and
TRACE 3-D.  A functional description of each part of the PowerTrace interface
is given in this section.  Familiarity with the preceding Section “Quick Start” is
assumed.  

PowerTrace User Manual

15



PowerTrace Application Screen

The PowerTrace application may be opened by double
clicking the application icon or on a PowerTrace Model
file.  Figure 3-1 illustrates the application screen after
launching PowerTrace.  The principal parts of the
PowerTrace application are the the Document Window,
the Menu  Bar and the floating Palette Bar.  There is
one Menu Bar and one Palette Bar for the application
but up to six Document Windows may be open at any
one time.

PowerTrace

PowerTrace application.

Example A Example B

PowerTrace Model files.

Build a Beamline Model by 
Selecting Elements from 

Palette Bar and Dragging them 
to the Model Space Pane of 

the Document Window.

Elements can be also be placed on the 
Work Space Pane of the Document 
Window.  These Elements are not 
considered part of the Beamline 

Model for TRACE 3-D.
Scroll Palette Bar to Access 

the Sixteen TRACE 3-D 
Beamline Elements and the 

Four Custom Elements.

Figure 3-1  PowerTrace Application Screen.

The Palette Bar will automatically grow to fit the
vertical size of your monitor and the Document
Windows will grow to fit the horizontal size.  The
Palette Bar will float above all Document Windows.
The Menus apply to the currently active Document
Window.
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Menu Bar 

There are seven pull down menus in the PowerTrace
Menu Bar.  Several of these menus also have submenus.
The first menu is the standard Apple ( ) menu whose
functions are established by the configuration of your
operating system.  This menu contains only one
command which is controlled by the interface.  This is
the About PowerTrace command which brings up a
window with information about the PowerTrace
application.  Figure 3-2 illustrates the next three pull
down menus:  File, Edit and View.  These are discussed
further below.  The remaining Menus: Commands,
Match, and Preferences are discussed in Sections 5, 4,
and 6, respectively.

New
Open
Close

Save
Save AsÉ

Import
Export

Page SetUp
Print Window

Quit

File

N
O
W

S

Q

Cut
Copy
Paste
Delete
Select All

Edit
X
C
V

A

√

Hide Palette

Hide Global Parameters

Show Tape 30
Show Tape 31
Show Aperture Data
Show PARMILA Data
Show History File
Clear History File

PowerTrace Model 1
PowerTrace Model 2

View

P

H

Figure 3-2.  PowerTrace File, Edit and View Menus.

File Menu

The File menu (Figure 3-2) has ten commands.  The
New and Open... menu commands will create and
activate a new PowerTrace Document Window.  A
currently active  Document Window will remain open
but will be deactivated.  The New command creates an
empty  Document  Window  while the Open... command
is used to open a previously saved model (defined by a
Document Window).  The Close command is used to
close the currently active  window.  
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The Save and Save As… commands are for saving the
PowerTrace model as defined in the currently active
Document Window.  The Import and Export commands
both have submenus for VAX and PC files.  Import and
Export are used to open and save TRACE 3-D models
in the (ASCII text) format of the VAX and IBM-PC
TRACE 3-D programs.  These are used for exchanging
TRACE 3-D input files with these platforms.  The Page
Setup and Print Window commands control printer
configuration and printing. The final command in the
File menu is Quit which closes all windows and quits the
application.

All of the File commands are similar to other
applications and follow standard Macintosh guidelines.
Many bring up standard dialogs for defining file names,
file locations (folders), etc.  Commands which cannot be
executed in a particular context are dimmed and are not
accessible.  Users unfamiliar with the Mac OS should
consult their Macintosh documentation for additional
information.

Edit Menu

The Edit menu (Figure 3-2) has five commands.  These
commands also follow standard Macintosh guidelines.
The current selection determines what actions are taken
with the Cut, Copy and Paste commands.  For example
the selection may be ASCII text, a numerical value, a
graphic image, or Pieces in the Document Window.
For numerical values, graphics or text information, the
Cut command makes a copy of the selection and then
deletes the selection.  If a single Piece or group of
Pieces is selected, the Cut command will delete the
selection from the Document Window, and without
changing the parameters, copy that selection to the
clipboard for future pasting in the current Document
Window or to another Document Window.  The Copy
command is also used to copy selected pieces, numerical
values, graphics or text information to the clipboard,
but without deleting the selection.  The Copy command
can be used to copy a PICT image of the TRACE 3-D
output window to the clipboard.

The Import and Export
commands are used for
exchanging input files with
V A X a n d I B M - P C
TRACE 3-D programs.

When Pieces are copied the
system clipboard is used to
store a PICT  image of the
Piece icons.  This image
can pasted into a word
processor or graphics
application.

The Copy command can be
used to copy a PICT image
of the TRACE 3-D   output
window which can be
pasted into a  word
processor or graphics
application.
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The clipboard image can then be pasted into a word
processor or graphics application.  The Paste command
places the current contents of the clipboard (if valid
PowerTrace Piece data) on the Work Space of the
Document Window.  See the discussion of the Document
Window later in this Section for additional information.
If text data is on the clipboard it can be pasted into the
different text windows of PowerTrace.  If numerical
data is in the clipboard it can be pasted into parameter
value fields.  The Delete command deletes any selected
Pieces from the Document Window, or deletes any
selected text data, but does not place the selection on the
clipboard.  Deleted data is permanently removed.  The
Select All command is used to select the entire group of
Pieces on the Model Space of the Document Window, or
all of the information in a text window, for subsequent
execution of Copy, Cut, Paste or Delete. 

View Menu

The View menu (Figure 3-2) has from eight to fourteen
commands depending on how many Document Windows
are open.  The Hide/Show Palette command allows the
user to show or hide the floating Palette Bar.  The
Hide/Show Global Parameters command lets the user
show or hide the Global Parameter Pane of the
currently active Document Window.  The next two
commands, Show Tape 30 and Show Tape 31 are used
to view the TRACE 3-D input file (Tape 30) for the
current Document Window and the return data file
(Tape 31) if TRACE 3-D has been executed.  These
files are discussed later in the “Data Structures and Data
Flow” subsection.  The Show Aperture Data command
is used to open a text window for the Aperture Data file
generated by TRACE 3-D.  The Aperture Data file is
produced with the execution of various TRACE 3-D
commands if the PowerTrace Option: “Generate
Aperture File” is on.  PowerTrace Options are
discussed in Section 6 “User Preferences”.  The Show
PARMILA Data command opens a text window for the
PARMILA Data file  generated by TRACE 3-D. 

Select All can be used to
select all of the beamline
elements in the active
Document Window.

Hide the Global Parameter
Pane to access more of the
Work Space Pane.

View the TRACE 3-D
input file with the Show
Tape 30 command and if
TRACE 3-D has been
executed, use the Show
Tape 31 command to view
the return data file .

The Show Aperture Data
command is used to open a
text window for the
A p e r t u r e D a t a f i l e
generated by TRACE 3-D
if the PowerTrace Option:
“Generate Aperture File” is
on.
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The PARMILA Data file is produced with the execution
of the PARMILA  Units command in the PowerTrace
Commands menu.  This file is discussed further in
Section 5 “TRACE  3-D Commands”.  The Show
History File command opens a text window for the
PowerTrace History file.  The History file  is a listing
of all the text based output generated by TRACE 3-D.
The History file can be cleared with the next command
in the View menu: Clear History File.  The History file
is discussed further in Section 5 “TRACE  3-D
Commands”.  

The remainder of the View menu lists the titles of all
open PowerTrace Document Windows, with a check
mark by the currently active document.  Selecting one
of these commands activates that Document Window
and brings it to the front.  As discussed above (and
further below) several commands result in operations
determined by the currently active Document Window.
Only one Document Window is active at a time and it
can be identified by the check mark in this menu.  

The functionality of the File, Edit and View menus are
very similar to other Macintosh applications, while the
Commands, Match and Preferences menus are
customized for TRACE 3-D.  These are discussed
separately in Section 4 “Matching Section”, Section 5
“TRACE 3-D Commands”, and Section 6 “User
Preferences”.

Palette Bar 

The PowerTrace Palette Bar contains Piece icons for
each of the transport elements used to build a beamline
model.  The Palette Bar automatically fits the vertical
size of your monitor so the number of piece icons
visible depends on monitor size.  There are scroll
controls on the top and bottom of the Palette Bar to
access  all of the Piece icons.  The title bar of the Palette
Bar window can be used to drag the Palette to different
locations on your screen.  The Palette Bar is a floating
window  which means it will “float” to the front if a
Document Window is placed over it.  

Show PARMILA  Data is
used to review  the output
from the PARMILA Units
command.

The History file is a
cumulative listing of all
t e x t o u t p u t t h a t i s
generated with multiple
runs of TRACE 3-D.

Selecting a Document title
from the View menu
brings that Document
Window to the front.

Scroll controls on the top
and bottom of the Palette
Bar are used to access all
of the available Piece
icons.
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Close Box Hides the Palette 
Bar.  Use the Show Palette 

Command in the View Menu 
to Restore the Palette Bar

Move the Palette Bar by Draging the 
Title Bar of the Window.  The Palette 

Bar Window will float on top of 
PowerTrace Document Windows

Scroll the Palette Bar to 
Access all of the 

PowerTrace Elements

Drag Elements from the 
Palette Bar to the Model 

Space or Work Space Pane 
of  the Document Window

Figure 3-3.  PowerTrace Palette Bar of Beamline Elements.

Figure 3-3 illustrates several different features of the
Palette Bar.  Piece icons are selected from the Palette
Bar and dragged to either the Model Space Pane or the
Work Space Pane of the Document Window.  The
Palette Bar contains twenty-two (22) different Piece
icons, including sixteen (16) native TRACE 3-D
elements, four (4) Custom element positions and two (2)
Pieces for the “Initial” and “Final” beam phase space
ellipse parameters.  These elements are listed in Table
3.1.  The PowerTrace Custom elements are discussed in
Appendix B “Customizing PowerTrace”.

D e s c r i p t i o n s f o r t h e
TRACE 3-D elements can
be found in Sections 4, 5
and 6 of the TRACE 3-D
Documentation.
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Table 3-1.  PowerTrace Beamline Elements.

Type
Code

Piece
Icon

Piece
Type

Type
Code

Piece
Icon

Piece
Type

- Initial Beam
(Twiss Parameters)

11 RFQ

1 Drift 12 Radio Frequency
Cavity

2 Thin Lens 13 Tank

3 Quadrupole 14 Wiggler

4 Permanent
Magnent 
Quadrupole

15 Rotate

5 Solenoid 16 Identical
(Initially Undefined)

6 Doublet - Custom 17
(Open Slot for
Custom Element)

7 Triplet - Custom 18
(Open Slot for
Custom Element)

8 Bend - Custom 19
(Open Slot for
Custom Element)

9 Edge - Custom 20
(Open Slot for
Custom Element)

10 Radio Frequency
Gap

- Final Beam
(Twiss Parameters)
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Document Window

The Document Window is divided into three areas
called panes.  These three panes are the Global
Parameter Pane, the Model Space Pane and the Work
Space Pane.  Figure 3-4 indicates the three principal
panes of the Document Window.

Beamline model in the 
Model Space Pane

Work Space PaneGlobal Parameter Pane Global Parameter Pane Scroll Bar

Transport Element Pieces 
on the Work Space Pane

Connection Points to Insert 
Pieces in the Beamline

Model Space Scroll Bars

Figure 3-4.  Principle Parts of the PowerTrace Document Window.

An important and unique feature of PowerTrace is that
multiple Document Windows, up to six, may be opened
at any one time.  The user can set up multiple TRACE
3-D problems, including the ability to exchange
beamline Pieces or groups of Pieces between them, and
run TRACE 3-D for any of the models.
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Global Parameter Pane

The Global Parameter Pane consists of the header
region, the close box, the scroll bar and the Global
Parameter Table.  The header region is at the top of the
pane and displays the title of the Global Parameters and
the other fields which include the current Value, the
Units, and the Limits (lower and upper).  The close
box, located in the upper right corner of the pane, hides
the Global Parameter Pane from view.  It is the same as
selecting the Hide Global Parameters from the View
menu.  To view the Global Parameter Pane, once
hidden, the user must select the Show Global
Parameters from the View menu.  The scroll bar on the
Global Parameter Pane is used to access additional
parameters in the Global Parameter Table.

Model Space Pane

The Model Space Pane of the Document Window is
where the transport pieces are placed to construct a
beamline model.  The Pieces assembled on the Model
Space constitute the beamline model whose data will be
used to run TRACE 3-D.  This model may be saved at
anytime using the appropriate commands from the File
menu.  

Pieces are “dragged” from the Palette Bar to the
Document Window.  Pieces may be placed on either the
Model Space or the Work Space in the Document
Window.  The first Piece that is “dragged” to the Model
Space may be placed anywhere on the Model Space.
Once the first Piece is placed, the following Piece
“snaps” on to the end closest to where the Piece was “let
go” when the mouse button was released.  The Model
Space Pane will automatically scroll to the end to which
the Piece is placed if this end is not visible in the
window.  

Several Unit pop ups scale
dynamically with particular
Global Parameters.

A beam line to be modeled
is built on the Model Space
Pane of a Document
Window.  

Pieces are selected from
the Palette Bar and
dropped onto the Model
Space.
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Pieces may also be placed at connection points in the
model which will insert the piece between two other
pieces in the beamline.  Connection points are
represented by lines between pieces in the beamline
model.  To insert a Piece or group of Pieces, drag the
selection over a connection point and release the mouse
button.  The connection point will flash while the mouse
is directly over it.  Releasing the mouse button inserts
the selection in the beam line model at that point.  Note
that there can never be “loose” pieces in the Model
Space.  All pieces are either inserted at connection
points or snapped to an end of the beamline model.

The two scroll bars of the Model Space Pane control the
positioning of the beamline model with respect to the
window (Figure 3-4).  The Model Space Pane is large
and can accommodate 300 beamline Pieces.  However,
if the intent is to build such a large model by starting at
one end of the beamline, the user should scroll to near
the corresponding end of the Model Space Pane, rather
than starting near the center of the Model Space.  

A Piece or a group of Pieces may be selected and
dragged from the Model Space to the Work Space Pane.
This action creates copies of the Piece(s) selected for
placement on the Work Space.  The original Pieces and
the data associated with them are unaffected and remain
on the Model Space.  A Piece or group of Pieces may
also be selected and copied, cut or deleted using the
appropriate commands from the Edit menu.  These
actions are very similar to the standard Copy, Cut and
Delete actions of many other applications.  The Delete
action removes the selected Pieces from the beamline
model - information associated with the Pieces is
permanently lost.

The Copy action makes a copy of the Pieces and stores
it on a PowerTrace internal “clipboard”.  The Pieces
may be later pasted onto any PowerTrace Document
Window (they will appear on the Work Space Pane).
The original Pieces and the data associated with them
are unaffected and remain on the Model  Space.

Connection Points

Pieces may be inserted into
the beam line at connection
points between pieces on
the Model Space.

Drag a box around a group
of Pieces in the beamline
model  to make a selection
of multiple Pieces.

Dragging a selection of
Pieces from the Model to
the Work Space creates
copies of the selected
pieces.
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A graphic  image (PICT) of the selected beamline
Piece(s) is also placed on the System clipboard.  This
image may then be pasted into other Macintosh
applications, for example, in order to prepare a figure
for publication.

The Cut action is similar to the Copy action, except that
the original Pieces and associated data are removed
from the Model Space.  Cut makes a copy of the Pieces
and associated information and stores it the same as with
Copy.  The complete information is on the PowerTrace
internal clipboard and the Pieces may be pasted onto
any PowerTrace Document Window.  A graphic image
of  the selected beamline Piece(s) is also placed on the
System clipboard and may be pasted into other
Macintosh applications.

In order for a PowerTrace model to be well-defined it
must have an Initial and Final Piece in the beamline
model.  These need not be at the ends of the beamline,
nor does the Initial Piece have to be before the Final
Piece, nor do any parameter inputs have to be made, but
the model will not be well-defined without them.  Each
model should only have one Initial and one Final Piece
to avoid confusion.  When saving a model, or updating
parameters for passing to TRACE 3-D, or during other
actions, PowerTrace will only retain the information on
one Initial and one Final piece.  (Which one
PowerTrace encounters first depends upon the action
being undertaken.)  Of course, additional Initial and
Final pieces, with or without other Pieces, may be
placed on the Work Space.

Work Space Pane

The Work Space Pane consists of the Work Space
“window shade” and a Pull Ring.  The Work Space
window shade is not scrollable, but it can be raised or
lowered, like a window shade, by dragging the Pull
Ring.  Double clicking the Ring will retract the shade
completely. 

Beam line information for
copied or cut pieces is
retained on the PowerTrace
internal clipboard .

The beamline model must
have an Initial and Final
Piece to run TRACE 3-D.  

The Work Space can be
raised or lowered, like a
w i n d o w s h a d e , b y
dragging the Pull Ring.
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Additional Work Space area may be accessed by hiding
the Global Parameters as  illustrated in Figure 3-5.
This may be done from the close box in the upper right
hand corner of the Global Parameter Pane, or by
selecting the Hide Global Parameters from the View
menu.  

Figure 3-5.  PowerTrace Document Window with 
the Global Parameter Pane Hidden.

Pieces may be placed on the Work Space either by
dragging them from the Palette Bar or the Model Space.
When a Piece, or a group of Pieces from the Model
Space, is dragged to the Work Space it can be placed
anywhere on the Work Space.  Pieces are not grouped
on the Work Space unless they were grouped prior to
being placed on the Work Space.  No Piece is snapped
to, or inserted into, a model structure when placed on
the Work Space.  A group of Pieces placed on the Work
Space will remain in their original configuration (i.e.
same order in line) and cannot be separated.  (Of
course, they can be dragged to the Model Space, a
subset selected, and then that subset placed on the Work
Space.)  A Piece or a group of Pieces may also be
copied, cut or deleted from the Work Space with the
same result as in the case of the Model Space (discussed
above).  There is only one internal PowerTrace
clipboard so that any existing data on it will be erased
when either Cut or Copy is executed.

When a Paste command is
executed, the existing set
of Pieces currently on the
clipboard will appear on
the Work Space.  They
may then be dragged to the
beam line in the Model
Space Pane.
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If Pieces or groups of Pieces have been previously
copied or cut, from either the Work Space or the Model
Space, they may be placed on the Work Space by
pasting them from the internal PowerTrace clipboard.
The Paste action is similar to that of other applications.
However, the Work Space is the only location to which
a previously cut or copied Piece, or group of Pieces,
will be pasted.  Pieces pasted to the Work Space may
then be dragged to the Model Space.  There may be
many individual “loose” Pieces or groups of Pieces on
the Work Space and they may be moved around and
located on the Work Space as desired.  These Work
Space Pieces are not part of the beamline model and
information associated with them is not retained when a
model is saved (Save, Save As, or Export commands
from the File menu).  However, Global Parameters
associated with the model are utilized for these Pieces,
for example in displaying “smart units” for the input
parameters and for the Ellipses in the Initial and Final
Pieces.  Similarly these Pieces are not used when a call
to TRACE 3-D is made from the Command menu.
Only the beamline model on the Model Space Pane of a
Document Window is used to define TRACE 3-D input.

The Work Space can be used for several purposes, for
example, to store a repeated set of Pieces which will be
used several times in a beamline.  Other uses include
comparing alternative “prototype” beamlines.  After
defining a set of Pieces, the prototype beamline can be
selected and dragged from the Model Space to the Work
Space.  An alternative set of parameters can be input to
the Model Space beamline while a “backup” of the
original is on the Work Space with the parameters
unchanged.  TRACE 3-D results for the new prototype
can then be compared directly to the original.  Other
possibilities will suggest themselves as the user becomes
familiar with the Work Space functions.  The
parameters of Pieces on the Work Space may be set
independently of the beamline Pieces on the Model
Space and are not affected by changes to the beamline
model. 

Selections on the Work
Space are moved by
dragging with the mouse.

Pieces on the Work Space
are only temporary. The
pieces on the Work Space
are not saved with the
Model fi le and are
d i s p o s e d w h e n t h e
Document Window is
closed.

The Work Space is useful
for temporarily storing
Pieces.  The Work Space
is most helpful when used
in conjunction with the
Model Space.
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Piece Windows and Data Tables

Parameter input for transport elements is done through
the Data Tables in PowerTrace Piece Windows.   Piece
Windows are accessed by “double clicking” the mouse
button while the cursor is on the desired transport
element icon in the Document Window.  Figure 3-6
illustrates a Piece Window for the Permanent Magnet
Quadrupole (PMQ) element.  Each Piece Window
consists of a Title Bar with close box and a Data Table.
The Data Table includes four fields of data:  (1) a
description of the Element Parameters, (2) a Value field
for data entry of the numerical parameters, (3) a Units
field which provides options through pop up menus and
(4) a Limits field which gives lower and upper limits
based on a expert system set of knowledge based rules. 

Input parameters are edited
using Data Tables.  The
Data Tables for each Piece
are contained in the Piece
Window. 

Limits rules are discussed
i n t h e A p p e n d i x
“Knowledge Base Rules
for Input Parameters of
TRACE 3-D”. Element
Parameters are defined in
Section 5  of the TRACE
3-D Documentation.

The Data Table Contains the 
Numerical Parameters for each 

Transport Element

Pop Up Menu 
Toggles between 
Limits Display or 
Match and Couple 

Selections

The Piece Window Title Includes 
the Sequence Number of the 

Element  in the Beamline and the 
Element Type Code

Figure 3-6.  Example of a PowerTrace Piece Window showing 
Match and Coupling Check Boxes for Piece Parameters.
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Parameter Value Fields

Several features of the Piece Window Data Table are
illustrated in Figures 3-6 and 3-7.  All numerical data is
entered into the Value fields of the Piece Window Data
Table.  Default values have been defined for all
parameters and these are the initial values when a Piece
icon is placed on the Model Space.  When a new value is
entered into a Value field the limits for that Piece
Window are updated.  (For some specialized Pieces that
interface with the FORTRAN, such as the Initial and
Final Pieces, certain data is not updated until the Piece
Window is closed.)

After entering a numerical
value, use the “Enter” key
to accept that value or click
outside of the Value Field.

Lower and Upper 
"Limits" Based on Expert 

"Rules of Thumb" and 
Similar Considerations --  
User is Alerted Visually if 

a Limit is Violated Pop Up Menu Allows 
Selection of Units.  These 
Can Include "Smart Units" 
Such As Displaying Any 

Length Dimensioned 
Parameter in Units of βλ

Figure 3-7.  Example of a PowerTrace Piece Window showing
Expert Limits and Smart Units Functionality.

Unit Pop Ups

The user may select different units for a parameter by
selecting the appropriate option from the Unit pop ups
as illustrated in Figure 3-7.  All unit conversions are
done by the Piece Window and all numbers transferred
to the data structure are in the default units, which are
the same  as  the  units  used  by  TRACE 3-D.  

Each Data Table provides
users with options for the
units of input parameters.
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Several Unit pop ups include “smart units.”  These are
units which scale dynamically with certain Global
Parameters.  For example, all parameters which have
the dimensions of length include “β-Lambda” as a units
option.  The value of the β, the relativistic velocity
parameter of the particle, is determined by the Global
Parameter values for the Particle Energy and Mass,
while the value of λ is set by the Radio Frequency
Global Parameter.  

Limits

Piece Windows also contain lower and upper “limits”
for each parameter.  These limits are not used to
restrict the input, any parameter value may be entered
and will be passed to TRACE 3-D via the PowerTrace
data structure. The limits are intended to provide the
user with estimates of a practical range for each
parameter.  A detailed description of individual limits
calculations including relationships with other
parameters for a given Piece and the Global Parameters
is presented in the Appendix  “Knowledge Base Rules
for Input Parameters of TRACE 3-D”.

Initial and Final Beam Pieces

There are two specialized Piece Windows for setting up
the initial and final beam parameters used by TRACE 3-
D.  When the Twiss Parameters option for the Initial
Beam Setup Global Parameter (TRACE 3-D IBS
parameter) is selected then the initial emittances (EMITI
array) and the initial Twiss parameters (BEAMI array)
are set by the user in the special Initial Emittance Piece
Window.  As with other Piece Windows this window is
opened by double clicking on the “Initial” Piece icon in
the Model Space.  This is illustrated in Figure 3-8.  If
the Sigma Matrix option is selected for the Initial Beam
Setup Global Parameter then a specialized dialog (not
shown) is opened via the Initial Piece.  The final Twiss
parameters (BEAMF, used for matching) are set via a
similar Piece Window, opened by double clicking on a
“Final” Piece icon.  It is important to note that both
Initial and Final elements are needed for a PowerTrace 

G u i d a n c e l i m i t s a r e
displayed for each Piece
Parameter.  However, the
guidance limits are “soft”,
and any value for an input
parameter may be used.

The limits calculations for
P i e c e P a r a m e t e r s a r e
described in the Appendix
“Knowledge Base Rules
for Input Parameters of
TRACE 3-D”.

Refer to subheading 9.2
and 9.3 from Section 9
“Input Variables” of the
T R A C E 3 - D
Documentation.

Both Initial and Final
Pieces are required for a
PowerTrace model to be
well defined.

PowerTrace User Manual

31



model to be well defined.  The Initial and Final Piece
Windows do not contain parameter Limits fields.
Instead, a graphic display of the phase space ellipses is
presented.  This display uses the TRACE 3-D graphics
scales and provides the user with a preview of how the
ellipse plots will appear after executing a Graph Beam
Line command.  These windows can also be used to
automatically set values for the TRACE 3-D graphics
scales if the “Use Graphics Scaling” Option is selected.
The Options are accessed from the Preferences menu
and are discussed in Section 6 “User Preferences”. If
the Use Graphics Scaling Option is on (default case), the
initial graphics scales (XMI, XPMI, DPMI and DWMI,
which set values for the boundaries of the initial phase-
space plots) are generated when the Initial Emittance
window is opened.  

Refer to subheading 9.5
from Section 9 “Input
Variables” of the TRACE
3-D Documentation.

Twiss Parameters
Sigma Matrix

Ellipse Display
Update

If the Twiss Parameters Option is Selected 
for the Initial Beam Set Up Global Parameter 

then Double Clicking the "Initial" Piece 
Brings Up a Specialized Piece Window

The Initial and Final Piece 
Windows Contain Ellipse Displays 

Rather Than Limit Fields

If the Update Option is Selected the 
Phase Space Ellipses are Redrawn 
Each Time a Data Entry is Made 

Double Click the Piece Icon 
to Open the Piece Window 

Figure 3-8.  PowerTrace Document Window and 
Initial Beam Piece Window.
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The following equations are used by PowerTrace to
initially estimate  values for the TRACE 3-D graphics
scales:

XMI = GraphScale1*SQRT((Betah)*(Emith)),
XPMI = GraphScale1*SQRT((Gammah)*(Emith)),

where Gammah = (1.0 + Alphah**2)/Betah.

Emith, Alphah and Betah are the current values for
these input parameters shown in the Initial Emittance
window.  This is repeated for the vertical plane, and the
larger of the two values of XMI and XPMI are used.
Similarly for the longitudinal plane 

DPMI = GraphScale3 *SQRT((Betaz)*(Emitz)),
and DWMI = GraphScale3*SQRT((Gammaz)*(Emitz)),
where Gammaz = (1.0 + Alphaz**2)/Betaz),

A similar scaling is done for the final graphics scales
(XMF, XPMF, DPMF and DWMF, which set values for
the boundaries of the final phase-space plots).  In this
case the output emittances are used (if Graph Beam Line
or a comparable TRACE 3-D command has been run)
unless they are zero (i.e. Graph Beam Line has not been
run) and then the initial emittances are used.  The
profile and projection graphics scales are then set as

YM = GraphScale2*larger(XMI,XMF),
DPP = GraphScale4*larger(DPMI,DPMF),
XM = GraphScale2*larger(XMI,XMF),

and XPM = GraphScale4*larger(XPMI,XPMF).

The values for the GraphScale factors used by
PowerTrace are:

GraphScale1 = 2.0 GraphScale2 = 1.2
GraphScale3 = 2.0 GraphScale4 = 1.2

This provides the user with an automatic initial set of
graphics scales to be used in the TRACE 3-D graphic
output.  The graphics scales are passed to the interface
data structure when the Initial or Final Piece windows
are closed.

Refer to subheading 9.5
from Section 9 “Input
Variables” of the TRACE
3-D Documentation.
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Data Structures and Data Flow

The PowerTrace interface is based on the Shell for
Particle Accelerator Related Codes (S.P.A.R.C.)
software technology written in the C programming
language.  It is designed to provide a common
Graphical User Interface (GUI) for multiple
applications.  TRACE 3-D is a FORTRAN code which
has been integrated with the PowerTrace GUI.  This
mixed language application uses specialized data
structures developed for transferring data between
S.P.A.R.C and the TRACE 3-D FORTRAN.  There is a
dynamic  data exchange between PowerTrace and
TRACE 3-D which is facilitated with data structures in
both C and FORTRAN that are identical in size and
reference a common block of memory. This block of
memory is accessed from both PowerTrace and TRACE
3-D and is shown schematically in Figure 3-9.  

C Language
S.P.A.R.C. GUI

C Language 
Interface Structure

FORTRAN
 Interface Structure

TRACE 3-D CommonsS.P.A.R.C. Data Structure
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A[i,j] */
short nxtra;      /* Number of extra 

parameters used */
double extra[10];  /* Array of extra 

parameters */
double sigi[6][6];  /* Initial Sigma-Matrix 
*/

double sig[6][6];   /* Sigma-Matrix */
double rm[6][6];   /* R-Matrix */
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ellipse  */
double emiti[3];   /* Beam Parameter: initial 

emitt */
double beamo[6];   /* Beam Parameter: output   

*/
double emito[3];   /* Beam Parameter: final 

emittances */
double beamf[6];   /* Beam Parameter: final 
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Shared data block 
in memory

Figure 3-9.  Mixed Language Data Interface.

As a beamline model is built all data defining the model
is stored in the S.P.A.R.C. data structure.  Certain
actions, such as selection of a TRACE 3-D command
from the Commands menu, initiates the mixed language
interface to pass the model data to (or from) the
FORTRAN.
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Although the data transfer is rapid and transparent to
the user, it involves a few well defined steps.  These are
discussed here briefly since an understanding of this
data flow can be capitalized upon to accomplish some
things not normally done with TRACE 3-D.

The PowerTrace to TRACE 3-D interface data transfer
involves the following steps. 

(1.) PowerTrace model data is passed to the C
Language Interface Structure which stores data in
the shared memory block.  The C Language
Interface Structure corrects for the different
storage schemes of the two languages.  The
PowerTrace model data may be viewed in the
FORTRAN text format of a TRACE 3-D input
file by selecting Show Tape 30 from the View
menu. 

(2.) PowerTrace calls a (SPARC) FORTRAN
interface routine, passing a pointer to the shared
data block in memory.  This defines the
FORTRAN Interface  Structure. 

(3.) The FORTRAN interface routine assigns data to
the TRACE 3-D common blocks TCOM and
ITCOM from the FORTRAN Interface Structure.
The data as passed to FORTRAN, may be viewed
using the Show TRACE 3-D Data command in the
Commands menu.

At this point the original action (i.e. selecting a TRACE
3-D command) that initiated this data transfer is
completed.  Note that the PowerTrace model data is
retained in the Data Tables independent of any actions
within TRACE 3-D that  alters the common block data.  

(4.) A FORTRAN interface return data routine
assigns data from the TRACE 3-D commons
TCOM and ITCOM to the shared memory block of
the FORTRAN Interface Structure.

Figure 3-10 shows an
example of the Tape 30
data in a PowerTrace
editable text window.

Refer to Section 9 “Input
Variables” of the TRACE
3-D Documentation.
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(5.) A pointer to the shared memory block is returned
from the FORTRAN Interface Structure to
PowerTrace. 

(6.) The return data is assigned from the shared
memory block to the C Interface Structure,
correcting for the different storage schemes of
the two languages.  However, this return data is
not automatically transferred to the Data Tables
(except  for  matching,  see  below).   The  return
data may be viewed in the text format of a
TRACE 3-D FORTRAN input file by selecting
Show Tape 31 from the View menu. 

All TRACE 3-D FORTRAN commons are maintained
when control returns to PowerTrace.  Variables in the
TCOM and ITCOM commons are passed back and forth
at each entry into, and return from, TRACE 3-D.  This
is because the user can modify this data in the Data
Tables of PowerTrace, and TRACE 3-D can modify
this data during execution of a user command.

To transfer the return data (“Tape 31”) to the Data
Tables select the Load Return Data (Tape 31 → Tape
30) command from the Commands menu.  PowerTrace
will automatically update the Data Tables with the
return data from TRACE 3-D after executing a match
command (Perform Matching, Match Without Print, or
Match in Range, see Section 5 “TRACE 3-D
Commands”).  However, this feature can be disabled
with a PowerTrace Option.  (see Section 6 “User
Preferences”).  No other TRACE 3-D command will
automatically update the PowerTrace Data Tables from
the TRACE 3-D return data. 

TRACE 3-D can be reinitialized with the Reinitialize
Trace 3-D item in the Commands menu.  This will
reinitialize the TRACE 3-D TCOM and ITCOM common
data.  Note that most internal arrays, such as the HOLD
array, are retained.  This effectively allows the “fresh”
restart of TRACE 3-D while maintaining the
PowerTrace model data and certain FORTRAN internal
data.

Figure 3-10 shows an
example of the Tape 31
data in a PowerTrace
editable text window.  

TRACE 3-D can modify
data during execution of a
user command.  This data
i s r e t u r n e d t o t h e
PowerTrace Interface with
the Load Return Data
command.

Automatic update of return
data from TRACE 3-D for
matching commands can
be turned on and off in the
Options dialog.

TRACE 3-D commons can
b e r e i n i t i a l i z e d u s i n g
Reinitialize Trace 3-D in
the Commands menu.
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&Data
er=  1875.0000, q=   1, w=     2.0000, xi=   100.0000
freq=     80.000, pqext=   2.50,ichrom=  0, ibs=  0, xc=     0.0000
smax=    5.0, pqsmax=    2.0
emiti(1)=    60.0000,    60.0000,  1000.0000
emito(1)=    60.0000,    60.0000,  1000.0000
beami(1)=     3.1140,     0.7536,    -2.6202,     0.5789,     0.1210,     0.568
beamf(1)=     0.0000,     0.4154,     0.0000,     1.3289,     0.0000,     0.357
beamo(1)=     0.0000,     0.4154,    -0.0000,     1.3289,    -1.3530,     0.487
beamci(1)=     0.0000,     0.0000,     0.0000,     0.0000,     0.0000,     0.00
xm=    17.9000, xpm=    58.4000
xmi=    13.4000, xpmi=    58.4000, ym=    21.4000, dpmi=    47.7000, dwmi=    8    
xmf=    17.9000, xpmf=    24.0000, dpmf=    37.8000, dwmf=   105.9000
n1=   1, n2=  20, nel1=   1, nel2=  20, np1=   1, np2=  20
mt=  8, nc=  4, delta=   0.000100, nit=  10
loc(1)=   0,   0,   0
xhw(1)=     0.0000,     0.0000,     0.0000
yhw(1)=     0.0000,     0.0000,     0.0000
mp=   1,   4,   1,   8,   1,  12,   1,  16,   0,   0,   0,   0
mvc=   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,  
ijm=   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,   0
val(1)=     0.0000,     0.0000,     0.0000,     0.0000,     0.0000,     0.0000
nprin=  0
nxtra=  0
nt(  1)=  11, a(1,  1)=    -0.7100,   110.4000,    86.4400,   -28.7000,     0.0
nt(  2)=  11, a(1,  2)=     0.7100,   110.4000,    86.4400,  -180.0000,     0.0
nt(  3)=   1, a(1,  3)=   173.0000
nt(  4)=   3, a(1,  4)=   -29.4633,    96.0000,     0.0000,     0.0000,     0.0
nt(  5)=   1, a(1,  5)=    39.7500
nt(  6)=  10, a(1,  6)=     0.1815,   -40.0000,     0.0000,     0.0000,     1.0
nt(  7)=   1, a(1,  7)=    39.7500
nt(  8)=   3, a(1,  8)=    32.4211,    96.0000,     0.0000,     0.0000,     0.0
nt(  9)=   1, a(1,  9)=    42.7400
nt( 10)=  10, a(1, 10)=     0.1815,   -40.0000,     0.0000,     0.0000,     1.0
nt( 11)=   1, a(1, 11)=    42.7400
nt( 12)=   3, a(1, 12)=   -37.3506,    96.0000,     0.0000,     0.0000,     0.0
nt( 13)=   1, a(1, 13)=    45.7400
nt( 14)=  10, a(1, 14)=     0.1815,   -40.0000,     0.0000,     0.0000,     1.0
nt( 15)=   1, a(1, 15)=    45.7400
nt( 16)=   3, a(1, 16)=    26.8805,    96.0000,     0.0000,     0.0000,     0.0
nt( 17)=   1, a(1, 17)=    48.7300
nt( 18)=  10, a(1, 18)=     0.1815,   -40.0000,     0.0000,     0.0000,     1.0
nt( 19)=   1, a(1, 19)=    48.7300
nt( 20)=   3, a(1, 20)=   -26.5000,    48.0000,     0.0000,     0.0000,     0.0
&end

&Data
er=  1875.0000, q=   1, w=     2.0000, xi=   100.0000
freq=     80.000, pqext=   2.50,ichrom=  0, ibs=  0, xc=     0.0000
smax=    5.0, pqsmax=    2.0
emiti(1)=    60.0000,    60.0000,  1000.0000
emito(1)=    60.0000,    60.0000,  1000.0000
beami(1)=     3.1140,     0.7536,    -2.6202,     0.5789,     0.1210,     0.568
beamf(1)=     0.0000,     0.4154,     0.0000,     1.3289,     0.0000,     0.357
beamo(1)=     1.7933,     0.4955,    -1.3759,     4.1635,    -1.4866,     0.455
beamci(1)=     0.0000,     0.0000,     0.0000,     0.0000,     0.0000,     0.00
xm=    17.9000, xpm=    58.4000
xmi=    13.4000, xpmi=    58.4000, ym=    21.4000, dpmi=    47.7000, dwmi=    8
xmf=    17.9000, xpmf=    24.0000, dpmf=    37.8000, dwmf=   105.9000
n1=   1, n2=  20, nel1=   1, nel2=  20, np1=   1, np2=  20
mt=  8, nc=  4, delta=   0.000100, nit=  10
loc(1)=   0,   0,   0
xhw(1)=     0.0000,     0.0000,     0.0000
yhw(1)=     0.0000,     0.0000,     0.0000
mp=   1,   4,   1,   8,   1,  12,   1,  16,   0,   0,   0,   0
mvc=   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,  
ijm=   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,   0,   0
val(1)=     0.0000,     0.0000,     0.0000,     0.0000,     0.0000,     0.0000
nprin=  0
nxtra=  0
nt(  1)=  11, a(1,  1)=    -0.7100,   110.4000,    86.4400,   -28.7000,     0.0
nt(  2)=  11, a(1,  2)=     0.7100,   110.4000,    86.4400,  -180.0000,     0.0
nt(  3)=   1, a(1,  3)=   173.0000
nt(  4)=   3, a(1,  4)=   -26.5000,    96.0000,     0.0000,     0.0000,     0.0
nt(  5)=   1, a(1,  5)=    39.7500
nt(  6)=  10, a(1,  6)=     0.1815,   -40.0000,     0.0000,     0.0000,     1.0
nt(  7)=   1, a(1,  7)=    39.7500
nt(  8)=   3, a(1,  8)=    26.5000,    96.0000,     0.0000,     0.0000,     0.0
nt(  9)=   1, a(1,  9)=    42.7400
nt( 10)=  10, a(1, 10)=     0.1815,   -40.0000,     0.0000,     0.0000,     1.0
nt( 11)=   1, a(1, 11)=    42.7400
nt( 12)=   3, a(1, 12)=   -26.5000,    96.0000,     0.0000,     0.0000,     0.0
nt( 13)=   1, a(1, 13)=    45.7400
nt( 14)=  10, a(1, 14)=     0.1815,   -40.0000,     0.0000,     0.0000,     1.0
nt( 15)=   1, a(1, 15)=    45.7400
nt( 16)=   3, a(1, 16)=    26.5000,    96.0000,     0.0000,     0.0000,     0.0
nt( 17)=   1, a(1, 17)=    48.7300
nt( 18)=  10, a(1, 18)=     0.1815,   -40.0000,     0.0000,     0.0000,     1.0
nt( 19)=   1, a(1, 19)=    48.7300
nt( 20)=   3, a(1, 20)=   -26.5000,    48.0000,     0.0000,     0.0000,     0.0
&end

Use Show Tape 30 and Show Tape 31 
to View the TRACE 3-D Interface Data

View

P

H

√

Hide Palette

Hide Global Parameters

Show Tape 30

Show Aperture Data
Show PARMILA Data
Show History File
Clear History File

PowerTrace Model 1
PowerTrace Model 2

Show Tape 31

Figure 3-10.  PowerTrace Text Windows Showing Input to
TRACE 3-D (Tape 30) and Returned Data (Tape 31).

Several other PowerTrace actions initiate data transfers
with TRACE 3-D.  While this is transparent to the user
and is unlikely to cause a problem, these actions are
summarized here for information purposes.  Opening
either an Initial or Final Piece Window, by double
clicking the Initial or Final Piece icons in a Document
Window, calls certain TRACE 3-D subroutines which
are used for displaying the emittance ellipses.  This
action will initiate the data transfer to TRACE 3-D. 
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Opening the Tape 30 window, by selecting Show Tape
30 under the View menu, can result in a call to the
TRACE 3-D FORTRAN when the window is closed if
the “Auto Update from Tape 30” Option is turned on.
This option is discussed in Section 6 “User
Preferences”.  Use of any of the Import commands
under the File menu also results in a call to the TRACE
3-D FORTRAN and initiates the data transfer.

This Section provides a description of the PowerTrace
user interface and defines terms used to refer to
different parts of the interface.  The following Section
discusses the use of PowerTrace to implement the
various matching options available in TRACE 3-D.  
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4.  Matching Options

The matching capabilities of TRACE 3-D are among its most powerful features.
This section discusses the use of PowerTrace to implement the various matching
options available in TRACE 3-D.  The set up of matching problems is the focus
of this section.  Actual match commands are discussed in the TRACE 3-D
Commands section.
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Matching Types

Several matching types are available in TRACE 3-D and
these are listed in Table 4-1 below.  The match type
indicates the type of beam matching or transport fitting
desired.  Types 1-4 specify that matched Twiss
parameters are to be found.  Type 13 specifies that
initial Twiss parameters are to be found to fit desired
final Twiss parameters.  Types 5-12 specify that values
are to be found for selected element parameters to fit
final Twiss parameters, or to fit selected R matrix or
Sigma matrix elements.  Type 14 specifies that values
are to be found for selected element parameters to fit
for desired phase advances in selected phase planes.

TRACE 3-D supports
fourteen different types of
beam matching and fitting.

Table 4-1.  Types of Matching in TRACE 3-D

MT Desired Values at End of Beamline
1 Vary initial beam for a matched beam in X,Y planes.
2 Vary initial beam for a matched beam in Z plane.
3 Vary initial beam for a matched beam in X,Y,Z planes (Upright).
4 Vary initial beam for a matched beam in X,Y,Z planes.
5 Vary element parameters to fit desired beam in X plane.
6 Vary element parameters to fit desired beam in Y plane.
7 Vary element parameters to fit desired beam in Z plane.
8 Vary element parameters to fit desired beam in X,Y planes.
9 Vary element parameters to fit desired beam in X,Y,Z planes.
10 Vary element parameters to fit desired R matrix elements.
11 Vary element parameters to fit desired Sigma matrix elements.
12 Vary element parameters to fit for round beam.
13 Vary initial beam to fit desired beam in X,Y,Z planes.
14 Vary element parameters to fit for specified phase advances 

in specified phase planes.

The PowerTrace Match menu is used to set the match
type and to access other matching data.  The match type
is specified with the Set Match Type submenu as shown
in Figure 4-1.  For this discussion matching types can
be divided into two groups:  “Find Matched Twiss
Parameters” and “Find Variables For Match”.  Match
types 1-4 are used to find matched Twiss parameters,
similarly match type 13 varies initial Twiss parameters
to match for desired final Twiss parameters.

The match type is specified
with the Set Match Type
submenu in the Match
menu.
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Match types 5-12 are used to find variables for a match
by varying element parameters (match variables) to fit
for a desired beam or to fit for desired R matrix or
Sigma matrix elements.  The match type is determined
by the TRACE 3-D match type parameter MT, which is
set by the PowerTrace interface when an item in the Set
Match Type submenu is selected.  

Show Match/Couple
Match Variables (MP)
Couple Params (MVC)
Special Params (VAL&IJM)
MT, NC, NIT & DELTA

Set Match Type
Match Preferences

10 - R Matrix
11 - Sigma Matrix

FIND VARIABLES FOR  MATCH

FIND MATCHED TWISS PARAMETERS
1 - ALPHA x,y & BETA x,y
2 - ALPHA z & BETA z
3 - BETA x,y,z
4 - ALPHA x,y,z & BETA x,y,z

5 - ALPHA x & BETA x
6 - ALPHA y & BETA y
7 - ALPHA z & BETA z
8 - ALPHA x,y & BETA x,y
9 - ALPHA x,y,z & BETA x,y,z

12 - Round Beam
13 - X, Y, Z Plane
14 - Phase AdvanceÉ

Figure 4-1.  PowerTrace Match Type Submenu.

The PowerTrace  interface sets the number of matching
conditions (N C) and has built in defaults for the number
of iterations and convergence criteria (NIT and
DELTA).  The parameters MT, N C, NIT and DELTA
may be viewed, and changed, by selecting the last item
in the Match menu shown in Figure 4-2.  This will
bring up the “Match Parameters” window which
displays the current values for these parameters.  

Match Variables (MP)
Couple Params (MVC)
Special Params (VAL&IJM)

Set Match Type

Match Preferences

Show Match/Couple

File  Edit  View  Commands

MT, NC, NIT & DELTA

Figure 4-2.  Match Parameters Window.

Match types are divided
into two general groups:
“Find Matched Twiss
Parameters” and “Find
Variables For Match”.

Refer to subheading 9.4
from Section 9 “Input
Variables” of the TRACE
3-D Documentation.
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Find Matched Twiss Parameters
(Match Types  1-4)

Once a beamline is defined the only action necessary for
setting up a matching problem to Find Matched Twiss
Parameters (match types 1-4) is to select the match type
in the Set Match Type submenu.  Once the match type is
specified, select the Perform Matching (or Match
Without Print) item in the Commands menu to execute
the TRACE 3-D matching procedure.  These commands
are discussed further in the Section 5 “TRACE  3-D
Commands”.

Find Variables For Match
(Match Types 5-12 & 14)

Once a beamline is defined, match variables must be
specified in order to Find Variables For Match (match
types 5-12 & 14).  These match types have been further
divided in the Set Match Types submenu according to
whether the objective is to adjust beamline element
parameters to achieve (a) specified final values of
certain Twiss parameters (match types 5-9),  (b)
specified values of selected R matrix elements (match
type 10) or Sigma matrix elements (match type 11),  (c)
fit for a round beam (match type 12), or  (d) fit for
specified phase advances in selected phase planes (match
type 14).  As with match types 1-4, the match type
parameter (MT) is set by the PowerTrace interface
when the corresponding item is selected in the Set
Match Type submenu. The value for N C is
automatically set, as are the built in defaults for NIT
and DELTA.  These may viewed and edited in the
“Match Parameters” window as discussed above.  For
match types 10 and 11 the value of N C is also set by
PowerTrace based on the number of goal values
specified for the R or Sigma matrix elements. Selection
of goal values is discussed later in the subsection
“Matching the R and σ Matrices”.

Setting up a problem to
F i n d M a t c h e d T w i s s
Parameters (MT=1-4) only
requires selection of the
match type.

Setting up a problem tto
Find Variables For Match
(MT=5-9) requires match
variables to be specified.

Refer to subheading 9.4
from Section 9 “Input
Variables”, of the TRACE
3-D Documentation.
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Match Variables and 
Coupling Parameters

Beamline element parameters which are to be varied by
TRACE 3-D (match variables) are specified from the
Piece Windows of beamline elements.  Each Piece
Window has a “Match/Couple” option on the Limits
pop-up menu.  Selecting this option displays check
boxes for each parameter which can legitimately be
varied during matching.  Checking a box in the Match
column assigns that parameter to be a match variable.
This is illustrated in Figure 4-3 for a PMQ Piece.  

M a t c h v a r i a b l e s a n d
Coupling parameters are
set using the Match and
Couple check boxes in
individual Piece Windows.

Pop Up Menu 
Toggles between 
Limits Display or 
Match and Couple 

Selections

Match & Couple Check Boxes 
for Each Parameter

Figure 4-3.  Selecting Parameters for Matching or Coupling.

PowerTrace automatically sets up the MP and MVC
arrays which are used by TRACE 3-D to define match
variables and coupling parameters.  When a Match or
Couple box is checked in a Piece Window, the number
of that parameter and the sequence of that element in
the model are entered into the first empty location in
the MP or MVC array.  If new elements are added to the
model, then the sequence values in the arrays are
adjusted appropriately.  If an element which has been
chosen for matching and/or coupling is deleted from the
model, then it is also deleted from the MP and/or MVC
array.  In this case the arrays are not reordered.  The
MP and/or MVC elements associated with the deleted
element are set to zero, so that the order of any other
conditions are preserved.  The empty spots will be filled
with any subsequent checking of matching or coupling
boxes by the user.

PowerTrace automatically
sets up the MP and MVC
arrays when a Match or
Couple box is checked in a
Piece Window.

Refer to subheading 9.4
from Section 9 “Input
Variables”, of the TRACE
3-D Documentation.
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The order in which the coupling parameters are selected
(i.e. when their Couple box is checked) is important
since that determines the matching variable with which
the parameter will be coupled.  A special window is
available to graphically display the status of the match
and coupling selections and their order in the MP and
MVC arrays. This window is opened with the Show
Match/Couple item in the Match menu and an example
is illustrated in Figure 4-4.

The order that coupling
parameters are selected is
i m p o r t a n t s i n c e t h a t
determines the matching
variable with which the
parameter will be coupled.

Piece Parameters Selected for 
Coupling in the Right Column 

are Coupled to the Piece 
Parameters Selected as Matching 

Variables in the Left Column

Viewing Status of 
Matching Variables and
Coupling Parameters

File  Edit  View  Commands

Match Variables (MP)
Couple Params (MVC)
Special Params (VAL&IJM)
MT, NC, NIT & DELTA

Set Match Type
Match Preferences

Show Match/Couple

Figure 4-4.  Example of the PowerTrace Window that 
Shows Match & Coupling Selections.

The contents of the MP and MVC arrays may also be
displayed and edited directly in the Coupling Window
and the Matching Window.  These windows are accessed
with the Match Variables (MP) and the Couple Params
(MVC) items in the Match menu as illustrated in Figure
4-5.

PowerTrace User Manual

44



The matching and coupling arrays can be changed
directly by entering new data in these windows.  The
coupling k values are given by the MVC(3,n) entries in
the Coupling Window.  The coupling k value, in the
MVC array is always defaulted to +1, but may be
changed to -1 in the Coupling Window  (Figure 4-5).

The MP and MVC arrays
may be edited directly in
the Coupling and Matching
Windows.

Input Windows for Directly 
Editing MP and MVC arrays 

which Specify Match Variables 
and Coupling Parameters

File  Edit  View  Commands

Show Match/Couple
Match Variables (MP)
Couple Params (MVC)
Special Params (VAL&IJM)
MT, NC, NIT & DELTA

Set Match Type

Match Preferences

Figure 4-5.  Input Windows for Directly Editing the
TRACE 3-D Coupling and Matching Data.

Matching the R and σ Matrices
(match types 10 & 11)

When the user selects either the R Matrix option (match
type 10) or the Sigma Matrix option (match type 11)
from the Set Match Type submenu, the Goal Selections
dialog window appears for inputting the goal values for
up to six (6) of these matrix elements.  The process for
making goal selections with these windows is the same
for either matrix.  The following discussion gives
examples for Sigma matrix matching; any differences
for  R matrix matching are noted.  

The Goal Selections dialog
window is used to specify
goal values for up to six  R
matrix or Sigma matrix
elements.
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When the R Matrix match type is selected, the Goal
Selections dialog displays the current values for the
TRACE 3-D 6x6 RM matrix.  If the Sigma Matrix
option (match type 11) is selected then the display gives
the current values of the TRACE 3-D 6x6 (final beam)
SIGI matrix (not the modified sigma matrix). 

Note that these initial matrices will be zero if
appropriate TRACE 3-D commands have not been
executed prior to the opening  of this dialog. Running
Graph Beam Line and the Load Return Data from the
Commands menu will compute these matrices and
provide initial values for these arrays based on the
existing beamline model.  The one-dimensional VAL
and two-dimensional IJM arrays are needed by TRACE
3-D to perform the match for MT = 10 and 11.  These
arrays are set by PowerTrace when data is entered into
the R matrix or Sigma matrix in the the Goal Selections
dialog window.  

The Goal Selections dialog has two modes:  the Matrix
mode and the VAL/IJM mode.  The user may switch
between the two modes using the radio buttons in the
lower left corner of the window.  Figure 4-6 shows an
example of both the Matrix mode used to set goal values
for R Matrix matching and the VAL/IJM mode which
displays VAL entries at IJM indices of the 6x6 matrix.  

The Goal Selections dialog is used to set the desired
values for matrix elements (goal selections).  Selecting a
check box beside an element identifies it as a potential
matching condition;  values for the selected elements are
the matrix elements which TRACE 3-D will try to
match.  PowerTrace automatically sets up the VAL and
IJM arrays in both display modes when the user adds or
removes goal selections by checking the boxes to the left
of the value fields and pressing the Add to VAL & IJM
or Remove from VAL & IJM button.  None of the data
input by the user is actually utilized until the add or
remove button is pressed.  The value for N C is
automatically set by counting the goal selections entered
by the user.

Refer to subheading 9.4
from Section 9 “Input
Variables”, of the TRACE
3-D Documentation.

Run Graph Beam Line and
Load Return Data from the
C o m m a n d s m e n u t o
provide initial values for R
and Sigma matrices based
on the existing beamline
model.

Select between Matrix
mode and VAL/IJM mode
with the radio buttons in
the lower left corner of the
Goal Selections Dialog.

No data input occures in
the Goal Selections dialog
until the Add to VAL &
IJM button is pressed.
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 Select Between Matrix and 
VAL/IJM Mode for Sigma or 

R Matrix Goal Selections 

VAL/IJM Mode of the Goal Selections Dialog 
Shows the Current Matrix Element Goal 

Selections Used for R Matrix (MT = 10) and 
Sigma Matrix (MT = 11) Matching

To Match desired R or Sigma Matrix Elements, 
Check Matrix Elements (up to 6) and Enter Goal 
Values then  Use the Add toVAL & IJM button

Run Graph Beam Line 
 Followed by the Load Return Data 

Command in order to Get Initial 
Sigma or R Matrix Element Values

 Matrix Mode Goal 
Selection for Sigma or 

R Matrix Matching

 VAL/IJM Mode Goal 
Selection for Sigma or 

R Matrix Matching

Figure 4-6.  Matrix Mode and VAL/IJM Mode of the 
Goal Selections Dialog for Sigma Matrix Matching.

While the current values of the R and Sigma matrices
are used to initialize the data in this dialog, the actual
RM and SIGI arrays in TRACE 3-D are not modified.
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To exit the Goal Selections dialog after accepting any
matrix goal selections, use the OK button.  To exit
without saving modifications, use the Cancel button.  If
the Cancel button is used to exit the dialog then the VAL
and IJM arrays will be restored to their contents before
the dialog was opened.

The VAL and IJM array values may also be accessed
directly in the Special Window which is opened with the
Special Params (VAL&IJM) item in the Match menu as
illustrated in Figure 4-7.  This window allows direct
modification of both the VAL and IJM arrays.  

The VAL and IJM arrays
may be edited directly in
the Special Window.

Special Window for Directly Viewing and 
Editing the VAL and IJM Arrays Used for 

R Matrix (MT = 10) and 
Sigma Matrix (MT = 11) Matching

PreferencesFile  Edit  View  Commands

Show Match/Couple
Match Variables (MP)
Couple Params (MVC)
Special Params (VAL&IJM)
MT, NC, NIT & DELTA

Set Match Type

Match

Figure 4-7.  Special Window to Directly Edit 
the VAL & IJM Arrays.

Matching for Round Beam
(match type 12)

Match Type 12 is used to vary element parameters to fit
for a round beam (equal X and Y envelopes at the end
of the beamline).  Matching variables (beamline element
parameters which are to be varied) must be specified as
described for match types 5-11.  

Match Type 12 is used to
vary element parameters to
fit for a round beam.
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Matching for X,Y,Z Planes
(match type  13)

Match Type 13 is used to vary initial Twiss parameters
(BEAMI) to fit a desired beam in X,Y,Z planes
(BEAMF).  The initial Twiss parameters in the Initial
Piece Window will  be  varied  by  TRACE 3-D  to  fit
a  desired final beam which is specified in the Final
Piece Window.  Once the desired final Twiss
parameters are specified the only action necessary for
setting up a matching problem is to select the match
type  in the Set Match Type submenu.  The Perform
Matching command can then be executed to find the
initial Twiss parameters that satisfy the desired final
beam.

Matching for Phase Advance
(match type 14)

Match Type 14 is used to vary element parameters to fit
for specified phase advances in specified phase-space
planes.  Match variables (beamline element parameters
which are to be varied) must be specified as described
for match types 5-11.  The desired phase-space planes
and phase advances are set in the Match for Phase
Advance Window illustrated in Figure 4-8.  This
window is automatically opened when the Phase
Advance match type is selected in the Set Match Types
submenu.

Match Type 13 is used to
vary the initial beam to fit a
desired final beam.

Match Type 14 is used to
vary element parameters to
fit  for  specified phase
advances.

Select Phase Space Plane 
for matching and the 

desired Phase Advances

Figure 4-8.  Match for Phase Advance Dialog.
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This Section provides a description of the PowerTrace
user interface for setting up various matching options
available in TRACE 3-D.  The following Section
discusses the use of PowerTrace Commands to execute
TRACE 3-D.
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5.  TRACE 3-D Commands

Running TRACE 3-D is accomplished directly from the PowerTrace interface.
The TRACE 3-D FORTRAN is fully integrated with the PowerTrace application.
This section discusses the Commands menu and the other PowerTrace
components which interact directly with the TRACE 3-D FORTRAN.
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The Commands Menu

The Commands menu illustrated in Figure 5-1, is used
to execute TRACE 3-D commands.  The majority of
commands  correspond directly to the  native  TRACE
3-D commands defined in the TRACE  3-D
Documentation.  The keyboard equivalents have been
retained.  For example, “Graph” is executed either by
selecting the Graph Beam Line command or entering

-G from the keyboard (press “G” while pressing the
apple command “ ” key).  Some keyboard equivalents
require the command and option keys to be pressed
along with the TRACE 3-D equivalent.  Keyboard
equivalents requiring command-option are noted in
Figure 2-6 which shows all of the PowerTrace
commands and the corresponding TRACE 3-D
commands.  

Commands
Graph Beam Line
Trace on Background
Find Ellipses from Profile
Plot Projections
Calculate Phase Advance
Exchange Beams
Calculate Mismatch

Perform Matching
Match Without Print
Match in Range (MT=7,8,9)
Show Match/Couple
Show Match Variables
Restore Prematch Variables

Show Beam Vectors
Show R Matrix
Show Modified Sigma
Show Phase & Energy
Show TRACE 3D Data

Load Return Data (31->30)
PARMILA Units
Help
Reinitialize TRACE 3D

G
T
L
J
F
Å
¿

M
N
U

Ã

B
R
Z
·
¹

�

E

(   -Option-X)

(   -Option-V)

(   -Option-W)
(   -Option-P)

(   -Option-K)

(   -Option-O)

G             GRAPH
T              TRACE
L              ELLIPSE
J               PROJECTIONS
F              PHASE
X             EXCHANGE
O             MISMATCH

M             MATCH
N             MATCH
U             USER

V             VARIABLES

B             BEAM
R             R-MATRIX
Z             SIGMA

C             CONVERT

TRACE 3-D
     Code

PowerTrace
 Command

W             φ-W

   PowerTrace 
Key-Equivalent

TRACE 3-D
 Command

!              UNMATCH

-

-
-

-

P             PRINT

Figure 5-1.  PowerTrace Commands Menu.

Some TRACE 3-D commands that are not present in
the PowerTrace Commands menu, (NEWFILE, INPUT,
ADD, DELETE, QUERY, SAVE and  END) are  effectively

Most of the PowerTrace
C o m m a n d s c o r r e s p o n d
directly to the native
TRACE 3-D commands
described in Section 10 of
t h e T R A C E 3 - D
Documentation.  
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incorporated into the PowerTrace user interface.  The
NEWFILE command equivalents in PowerTrace are the
New and Open commands in the File menu.  The
INPUT, ADD, DELETE and QUERY commands are not
used since the PowerTrace interface handles these
functions with graphical beamline set up and access to
element parameters by double-clicking Pieces in the
beamline model.  The SAVE command equivalents in
PowerTrace are the Save, Save As and Export
commands in the File menu.  The END command is
equivalent to Quit in the File menu.  These menu
commands are discussed in Section 3 “PowerTrace
Interface”.  Two other TRACE 3-D commands,
CENTROID and APERTURE are integrated into the
PowerTrace interface.  The CENTROID equivalent in
PowerTrace is the Centroid Parameters command in the
Preferences menu, which provides access to beam
centroid offsets.  The APERTURE command is
implemented in PowerTrace as a user option.  This is
described in the “Generate Aperture File” subsection in
Section 6 of this manual.  Two TRACE 3-D display
commands which are not implemented in the
PowerTrace interface are NOTE and COMMENT.

PowerTrace Commands are organized in four
functional groups.  The first group contains beam
dynamics related commands.  The second group of
commands are for matching operations.  The third
group contains display commands and the last group
includes some PowerTrace specific commands and
miscellaneous TRACE 3-D commands.  Most commands
result in output to one of two different PowerTrace
windows.  Matching and display commands send output
to a Text Output Window.  Graph Beam Line and
related commands send output to a Graphic Output
window.  

Commands will be dimmed and not accessible if the
front window is not a Document Window or one of the
two Output Windows.  Other commands such as
Calculate Phase Advance and Show Modified Sigma, are
dimmed prior to execution of a Graph command.  Some
commands that are interactive, use a PowerTrace dialog

Refer to Table IV from
S e c t i o n 8 “ U s e r
I n s t r u c t i o n s ” o f t h e
T R A C E 3 - D
Documentation.

The Show TRACE  3-D
Data command can also be
used to examine the input
from the FORTRAN after
the data exchange has
occurred.

C o m m a n d s w i l l b e
dimmed i f  the front
window is not a Document
or one of the Output
Windows.

PowerTrace User Manual

53



after initial processing by TRACE 3-D.  The dialog
windows can be moved by dragging the title bar if they
are covering previous output from TRACE 3-D.  After
responding to the dialog, processing of the command
will continue.

Text Output Window

Text output from TRACE 3-D is sent to a Text Output
window.  The title of the window will be the same as
the active Document Window.  The Text Output
window has a default size and location based on the size
of your monitor.  The Text Output window has a fixed
width but can be resized vertically.  Text output is
appended to previous output when the window remains
open.  When output reaches the bottom of the window,
it is cleared and resumes from the top.  A continuous
text file is also written (History file) which contains
everything that is displayed in the Text Output window.
After a command has completed, any data cleared from
the Text Output window can be viewed using the Show
History File command in the View menu.  The History
file will hold up to 32K characters, but this can be
exceeded after continuous commands are executed.
Rename, copy or clear the file to prevent history data
from being lost.  

Graphic Output Window

Graphic output from TRACE 3-D is sent to a Graphic
Output window.  The title of the window will be the
same as the active Document Window.  The Graphic
Output window has a default size and location based on
monitor size but can be resized in both vertical and
horizontal directions.  The current window contents are
not re-scaled.  When the window is left open after being
resized, the graphic output will be scaled for the new
window size with the next command.  The Graphic
Output window can not be resized smaller than the
minimum size required for TRACE 3-D graphic output.
The size is only limited by the size of the monitor.

PowerTrace dialogs can be
moved if they are covering
previous output from
interactive TRACE  3-D
commands.

The History file can be
cleared automatically prior
to executing TRACE 3-D
commands.  See Section 6
“User Preferences”. 

When resized and left open
t h e G r a p h i c O u t p u t
window will scale the
output for the new size on
the next execution of a
TRACE 3-D command.
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Beam Dynamics Commands

Graph Beam Line

The Graph Beam Line ( -G) command generates the
TRACE 3-D beam envelopes and phase-space ellipses in
the Graphic Output window.  Figure 5-2 shows the
result of executing the Graph Beam Line command
using the Example B model distributed with the
application and described in the TRACE 3-D
Documentation.  The beamline elements are drawn first
in the profile box at the bottom of the window.  The
initial phase space ellipses are then drawn.  Horizontal
(solid red) and vertical (dashed blue) ellipses in the top
plot and longitudinal (dashed green) in the bottom plot.
If the Initial Piece is to the right of the Final Piece in
the beamline model, then the initial ellipses will be
drawn on the left-hand side of the window; if the Initial
Piece is to the right of the Final Piece in the beamline
model then the beam traverses the model in the reverse
direction and the initial ellipses will be drawn on the
right-hand side of the window.  Beam envelopes are
then drawn in the beam profile box at the bottom of the
window.  The horizontal (solid red) and longitudinal
(dotted green) beam profiles in the upper half of the
profile box and the vertical (dashed blue) profile in the
lower half.  After the beam envelopes are complete, the
final ellipses are drawn followed by various parameter
values which are displayed in the center of the window
as shown in Figure 5-2.  

Trace on Background

The Trace on Background ( -T) command generates
beam envelopes and phase-space ellipses over the output
from a previous Graph Beam Line command.  The
Trace command will be dimmed if a Graph command
has not be executed.  The Trace command is not useful
if the beamline length has been changed or the Graphic
Output Window has been resized since the last Graph
command.

The Graph Beam Line
command generates the
beam envelopes and phase-
space ellipses in the
Graphic Output window.

The Trace on Background
command allows direct
comparison o f  beams
before and after parameter
changes.
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Figure 5-3 shows the results from the Trace on
Background command, displayed over the Graph
example illustrated in Figure 5-2, after the Perform
Matching command was executed to convergence.

Figure 5-2.  Output from the Graph Beam Line Command.

Figure 5-3.  Example of Trace on Background Command.
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Find Ellipses from Profile

The Find Ellipses from Profile ( -L) command is an
interactive command which is used to determine the
ellipse parameters and emittances in the two transverse
planes based on measurements of beam half-widths at
three locations in the beamline.  After the command is
selected, ellipses and profile plots are generated in the
Graphic Output window followed by a PowerTrace
dialog that is used to input the location for profile
measurements and the corresponding horizontal and
vertical beam half-widths.  Figure 5-4 shows an
example of the initial Graph and the input dialog, as
well as the resulting graphic output with the specified
measurement locations marked.  If a realistic solution is
found, the calculated emittances are displayed and the
transverse beam profiles are plotted over the three
specified locations. 

The Find Ellipses from
Profile command is used to
find emittance ellipses
from three different profile
measurements.

Initial Graph executed with 
the Find Ellipses from 

Profile Command PowerTrace Dialog for 
Selecting Beamline Locations 

and Half-Widths

Resulting Output for 
Realistic Solutions

Figure 5-4.  Ellipses from Profile Measurements Command.
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Plot Projections

The Plot Projections ( -J) command requires the
previous execution of a Graph command and will be
dimmed if a Graph command has not be executed.
Projections of the beam in x-y, x-z and x-∆p/p are
displayed in the Graphic Output window.  The upstream
end of the system is shown on the left-hand side of the
window and the downstream end on the right.   Figure
5-5 shows the resulting display after executing the Plot
Projections command.

T h e P l o t P r o j e c t i o n s
command is used to plot
initial and final projections
on x-y, x-z and x-∆p/p
planes.

Figure 5-5.  Output from the Plot Projections Command.
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Calculate Phase Advance

The Calculate Phase Advance ( -F) command is used to
calculate and display the phase advance (deg) and the
Twiss (α & ß) beam ellipse parameters for each of the
three phase-space planes.  This command requires a
previous execution of the Graph command.  The phase
advance is given in degrees, alpha and beta are in
mm/mrad.  The results are sent to the Text Output
window.  As with all text output from TRACE 3-D,
this data is also written to the cumulative History file.
An example of the resulting output from this command
is shown in Figure 5-6.

T h e C a l c u l a t e P h a s e
A d v a n c e c o m m a n d
calculates and displays the
the phase advance and
Twiss parameters for the
three phase-space planes

Figure 5-6 Output from Calculate Phase Advance Command.

Exchange Beams

The Exchange Beams ( -Option-B) command is used to
store beam parameters in up to fourteen different
holding positions, and then later exchange these back to
either the initial or the final beams.  Beams are stored
in the 6 by 14 HOLD array of TRACE 3-D.  The
Exchange Beams command is an interactive command
that uses a PowerTrace dialog to input parameters for
the beam selection (initial, final or output), the holding
position (1-14) and the exchange direction (to or from a
hold position).  The Text Output window is used to
display the current beam vectors as well as any beams
already in the hold array.  The Exchange Beams dialog
is then used to specify the exchange parameters.  

The Exchange Beams
command is used to store
and retrieve beam-ellipse
parameters.
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After closing the Exchange Beams dialog, results of the
exchange are displayed as shown in Figure 5-7.  

BEAM VECTORS:
 beami: x=    3.1140    0.7536 y=   -2.6202    0.5789 z=    0.1210    0.5687
 beamf: x=    0.0000    0.4154 y=    0.0000    1.3289 z=    0.0000    0.3570
 beamo: x=    0.0000    0.0000 y=    0.0000    0.0000 z=    0.0000    0.0000

 14 Hold Positions Available
THERE ARE NO BEAMS STORED

INITIAL BEAM STORED IN POSITION  1
 hold1: x=    3.1140    0.7536 y=   -2.6202    0.5789 z=    0.1210    0.5687

Select Between 
Initial, Final or 
Output Beams

Exchange Beams 
To or From 

Holding Positions

Enter Desired Hold Position 
Number or Use the Arrow 
Control to Select Between 
Fourteen Holding Positions

After Closing the Exchange Beams 
Dialog, the Results are Written to 

the TRACE 3-D Text Window

Before Opening the Exchange Beams Dialog
the Initial, Final and Output Beams are displayed in 
the TRACE 3-D Text Window, in Addition to Any
Beams Currently Stored in the Holding Array and

the Number of Available Hold Positions

Figure 5-7.  Exchange Beams Command.

The function of the Exchange Beams command is
essentially the same as the standard TRACE 3-D
command. However, when using Exchange Beams to
take data from the holding positions for use either as the
initial or final beam in a subsequent command, the user
should execute the Load Return Data (31→30) after
executing Exchange Beams. The “Holding Position →
Beam” returns beam data  through  the Tape 31 (return) 

Use the “Auto Update
After Match or Exchange”
Option to always update
after an Exchange Beams
command.
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data structure; this must be reloaded into the Tape 30
(input) data structure to be used in a subsequent
calculation, as described in Section 3 “PowerTrace
Interface”.

Calculate Mismatch

The Calculate Mismatch ( -Option-O) command
calculates and displays the mismatch factor between the
output beam (BEAMO) and the desired final beam
(BEAMF).  A match type must be set in the Set Match
Type submenu of the the Match menu.  Output is
directed to the Text Output window.  Figure 5-8
illustrates the resulting output from the Mismatch
command, before and after the Perform Matching
command.  The Show Match Variables command was
also used to generate the output shown in Figure 5-8.
These commands are described in the following
subsection.

The Calculate Mismatch
command calculates and
displays the mismatch
factor between the output
and final beams. 

A  definition o f  the
m i s m a t c h f a c t o r i s
presented in Appendix C
“Mismatch Factor” in the
T R A C E 3 - D
Documentation.

MATCH VARIABLES:
       MP          VALUE
 param,sequence
    1       4         -26.5000
    1       8          26.5000
    1      12         -26.5000
    1      16          26.5000

MISMATCH FACTORS:
 MMFx=    1.122568, y=    0.947500

MATCHING... (NIT=    30)
    1.122568   -26.500000   26.500000  -26.500000   26.500000
    2.437808   -30.591502   26.604968  -23.282943   26.841247
    0.544419   -23.915922   25.847169  -24.694673   25.417714
    1.017563   -27.036087   28.241554  -27.207524   26.444065
    1.400462   -25.976358   27.174954  -27.916941   27.899467
    0.411105   -23.559257   26.630471  -24.268055   25.609316
    0.133408   -23.648349   27.638375  -23.092963   24.936274
    0.091104   -23.462245   27.536202  -21.658321   24.576331
    0.024767   -23.441206   27.387535  -22.086308   24.712357
    0.002486   -23.448828   27.393426  -22.253266   24.752873
    0.001023   -23.440648   27.409513  -22.288122   24.758669
    0.000222   -23.444663   27.407170  -22.282748   24.758886
    0.000017   -23.444121   27.406558  -22.281577   24.758669

MATCH VARIABLES:                                                                 
       MP          VALUE                                                         
 param,sequence                                                                        
    1       4         -23.4441                                                         
    1       8          27.4066                                                         
    1      12         -22.2816                                                         
    1      16          24.7587

MISMATCH FACTORS:
 MMFx=    0.000004, y=    0.000017

Perform Matching

Show Match Variables

Calculate Mismatch

Show Match Variables

Calculate Mismatch

Figure 5-8.  Example Using the Calculate Mismatch Command.
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Matching Commands

There are six different commands to perform matching
or display match and coupling data.  The use of these
commands is described here. Section 4 “Matching
Options” describes the steps for setting the match type
and specifying match variables for a matching problem.
The Perform Matching, Match without Print and Match
in Range commands are used to find matched-ellipse
parameters or values of specified match variables, to fit
the final beam or specified matrix elements, depending
on the particular match type selected.  The match
commands search for a solution to a set of nonlinear,
simultaneous equations in an iterative procedure.  The
number of iterations (NIT) and the convergence factor
(DELTA) are set from the Match Parameters window as
described in Section 4 “Matching Options”.  If a
solution has not been found within the specified
number of iterations, then the match variables will be
set to the values found which minimize the convergence
factor.  

Perform Matching and
Match without Print

After setting up a matching problem, the Perform
Matching ( -M) and Match without Print ( -N)
commands can be used to start the matching process.
The match type must be set prior to execution of these
commands.  As their names imply, both commands
perform matching, the first displays matching progress
and the second does not.  Output from the matching
process includes the convergence criteria and the values
for each of the match variables at every iteration.
Figure 5-8 on the previous page illustrates output
resulting from the Perform Matching command.
Matching will proceed until the  convergence factor
(first column) falls below the user specified value or the
number of iterations has been reached.  Two beeps are
sounded when the matching process converges.  Values
for the match variables appear left to right in the order
they are held in the MP array.  

The Matching  procedure
can be terminated using
c o m m a n d - p e r i o d ( - . ) .
The matching variables
will be set to the values
from the last match
iteration.

The Perform Matching and
M a t c h w i t h o u t P r i n t
c o m m a n d s s t a r t t h e
matching process.

The Load Return Data
c o m m a n d m u s t b e
e x e c u t e d f o l l o w i n g a
matching command, to
update model parameters
from match variables.

Use the “Auto Update
After Match or Exchange”
Option to always update
m a t c h v a r i a b l e s a f t e r
matching.
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Match in Range

The Match in Range ( -U) command performs
matching in a user specified range and step size for each
of the match variables.  The Match in Range command
is used for match types 7-9.  It is an interactive
command which brings up a PowerTrace input dialog,
illustrated in Figure 5-9.  Each element with a
parameter selected as a match variable is listed with it’s
Piece icon, sequence in the beamline model, type code,
and name. The name and current value of each
parameter to vary is also displayed.  The user must
input the range of variation and the step size.
PowerTrace sets initial defaults for the Minimum and
Maximum Range values of each parameter to be varied,
as well as the Step Size to be used between these two
limits. 

The Match in Range
c o m m a n d p e r f o r m s
matching in  a  user
specified range and step
size.

Default values for the
range are 90% and 110%
of the current value of the
match variable.  The
default step size is one-
fifth of the extent of the
range, i.e. (Max - Min)/5

Empty Slots for 
Match Variables 
in the MP array

Match Variables are displayed with 
the Parameter Name and Current 
Value as well as the Piece Icon, 
Sequence in the Model, Element 

Type Code and Name

Check Box to Show Matching 
Progress at Each Iteration

Input Fields for the Lower 
Range, Upper Range and Step 
Size for Each Match Variable

Figure 5-9.  Match in User Specified Range Dialog Window.

The Match in Range procedure can take a long time to
complete, especially if more than one match variable is
being varied.  An estimate of the maximum time needed
can be made by multiplying the time for a Graph
command to execute by the total number of iterations.
The total number of iterations is given by the combined
product of the number of steps for each variable.

The Match in Range
procedure can take much
longer to complete than the
Perform Match command
with similar results.
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Show Match/Couple

The Show Match/Couple command opens a PowerTrace
window (illustrated in Figure 5-10) that graphically
displays the status of the match and coupling selections
and their order in the MP and MVC arrays. This
window can also be accessed from the Match menu and
is discussed in Section 4 “Matching Options”.

The Show Match/Couple
command displays the
m a t c h a n d c o u p l i n g
selections.

Commands
Graph Beam Line
Trace on Background
Find Ellipses from Profile
Plot Projections
Calculate Phase Advance
Exchange Beams
Calculate Mismatch

Perform Matching
Match Without Print
Match in Range (MT=7,8,9)

Show Match Variables
Restore Prematch Variables

Show Beam Vectors
Show R Matrix
Show Modified Sigma
Show Phase & Energy
Show TRACE 3D Data

Load Return Data (31->30)
PARMILA Units
Help
Reinitialize TRACE 3D
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Show Match/Couple

Piece Parameters Selected as Match 
Variables are listed in the order they 

are stored in the MP array

Figure 5-10.  Show Match/Couple Command.

Show Match Variables

The Show Match Variables ( -Option-V) command is
used to display the current values for parameters
selected as match variables.  .For this command to
generate any output, the match type must be set to a
“Find Variables for Match” type (MT=5-9).  Figure 5-
11 illustrates the output from this command in
combination with the Perform Matching and Restore
Prematch Variables commands.

The Show Match Variables
command displays the
selected match variables.
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Restore Prematch Variables

As the name implies, the Restore Prematch Variables
command is used to restore match variables to their
values prior to the last matching procedure.  This
command only applies to match types which “Find
Variables for Match” (MT=5-9).  Figure 5-11 shows the
resulting output of this command using the Show Match
Variables command to illustrate prematch variables,
Perform Matching to modify the match variables, and
then using the Restore Prematch Variables command to
“unmatch” the variables.

The Restore Prematch
Variables command can
restore the values of match
variables prior to the last
matching command.

PREMATCH VALUES RESTORED

MATCH VARIABLES:
       MP        VALUE
 param,sequence
   1       4       -26.5000
   1       8        26.5000
   1      12       -26.5000
   1      16        26.5000

MATCHING... (NIT=    10)
    1.122568   -26.500000   26.500000  -26.500000   26.500000
    1.579695   -21.761137   27.306817  -25.207615   30.851469
    1.610566   -25.503277   23.481038  -25.972580   26.385324
    1.391865   -27.897962   29.372619  -26.544495   28.041062
    1.159095   -27.398653   28.017561  -25.619691   25.651434
    0.514964   -24.521208   28.253876  -25.667958   24.717008
    0.404214   -23.931734   27.281939  -24.474722   24.624680
    0.168278   -23.317907   26.181216  -21.941392   24.702989
    0.051912   -23.365165   27.176923  -21.867495   24.642102
    1.490016   -21.451646   18.221472   -9.033097   22.301867
    0.014922   -23.493914   27.474213  -22.313924   24.721919
    0.010148   -23.454632   27.385970  -22.182849   24.732963
    0.013446   -23.461484   27.378910  -22.147615   24.718370
    0.000160   -23.444183   27.407656  -22.283489   24.759708
    0.000010   -23.444049   27.406590  -22.281830   24.758736

MATCH VARIABLES:
       MP        VALUE
 param,sequence
   1       4       -23.4440
   1       8        27.4066
   1      12       -22.2818
   1      16        24.7587

MATCH VARIABLES:
       MP        VALUE
 param,sequence
   1       4       -26.5000
   1       8        26.5000
   1      12       -26.5000
   1      16        26.5000

Restore Prematch 
Variables

Show Match Variables
(                    )-Option-V

Perform Matching
(          )-M

Figure 5-11.  Restore Prematch Variables Command.

Note that the Restore Prematch Variables command can
only restore values prior to the last match procedure.
If the Preform Matching command is executed more
than once to achieve convergence, this command will
only restore the values prior to the last match attempt.
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Display Commands

A variety of commands are available for displaying data
before and after a Graph command has been executed.
Figure 5-12 illustrates the Text Output window after
executing the Show Beam Vectors, Show R-Matrix,
Show Modified Sigma, and Show Phase and Energy
commands.  This output is from Example B after
matching to convergence.

Show Beam Vectors

The Show Beam Vectors ( -B) command is used to
display all of the TRACE 3-D beam vectors.  The initial
beam (BEAMI), the final beam (BEAMF) and the output
beam (BEAMO) are displayed, followed by the beam
centroid offsets (BEAMC) and the initial beam centroid
offsets (BEAMCI).  All non-zero beams currently stored
in the HOLD array are also displayed.  The output for
this command is illustrated in Figure 5-12.  

Show R Matrix

When a Graph command is executed the 6x6 transfer
matrix is stored in the RM array.  The Show R Matrix
( -R) command displays this R matrix.  A description
of the R matrix for each element can be found in
Section 6 “Transfer Matrices” in the TRACE  3-D
Documentation.    An example of the output generated
by this command is illustrated in Figure 5-12.

Show Modified Sigma

The Show Modified Sigma ( -Z) command displays the
modified Sigma matrix in the Text Output window.
The Show Modified Sigma command will be dimmed
prior to executing a Graph command.  An example of
the resulting output from the Show Modified Sigma
command is shown in Figure 5-12.  

Use the Show Beam
Vectors command in place
of  the TRACE 3-D
CENTROID command to
display the beam centroid
offsets.
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BEAM VECTORS:
  beami: x=    3.1140    0.7536 y=   -2.6202    0.5789 z=    0.1210    0.5687
  beamf: x=    0.0000    0.4154 y=    0.0000    1.3289 z=    0.0000    0.3570
  beamo: x=    0.0000    0.4154 y=    0.0000    1.3289 z=   -1.2261    0.4169
  beamc: x=    0.0000    0.0000 y=    0.0000    0.0000 z=    0.0000    0.0000
  beamci:x=    0.0000    0.0000 y=    0.0000    0.0000 z=    0.0000    0.0000

BEAMS IN HOLDING POSITIONS:
  hold1: x=    1.7933    0.4955 y=   -1.3759    4.1635 z=   -1.4866    0.4551
  hold2: x=    0.0000    0.4154 y=    0.0000    1.3289 z=   -1.2261    0.4169
  12 Hold Positions Available

R-MATRIX:
    0.761061     0.329412     0.000000     0.000000     0.000000     0.000000
   -5.551055    -1.088724     0.000000     0.000000     0.000000     0.000000
    0.000000     0.000000    -4.047924     0.875751     0.000000     0.000000
    0.000000     0.000000    -0.972379    -0.036670     0.000000     0.000000
    0.000000     0.000000     0.000000     0.000000     0.478015     0.710460
    0.000000     0.000000     0.000000     0.000000    -1.628571    -0.328514

MODIFIED BEAM MATRIX  (mm, mrad, %dp/p)
    4.992399
   12.018270   -0.000008
    8.929452    0.000000     0.000000
    6.719337    0.000000     0.000000    -0.000034
    9.808736    0.000000     0.000000     0.000000     0.000000
    1.938342    0.000000     0.000000     0.000000     0.000000    -0.774942

LONGITUDINAL DYNAMICS AND PHASE-SPACE:
  Phi=151.1602 deg,  W=    2.000000 MeV
  DP=   20.417475 deg,  DW=   77.492374 KeV
  DZ=    9.808736 mm,  DP/P=   19.383420 mrad, Ez=  120.166232 -mm-mrad

Show Beam Vectors

Show R Matrix

Show Modified Sigma

Show Phase & Energy

Figure 5-12.  Example of Resulting Output from 
Various Display Commands.

Because the Sigma matrix is a symmetric matrix, only
half of the elements are displayed.  The format is shown
in Figure 5-13 below.

x max

x 'max

y max

y 'max

z max

∆p
p max

r12

r13

r14

r15

r16

r 23

r 24

r 25

r 26

r 34

r 35

r 36 r 56

r 45

r 46

Figure 5-13.   Modified Sigma Matrix Format.
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Show Phase & Energy

The Show Phase & Energy ( -Option-W) command is
used to calculate and display the phase advance in
degrees and the Twiss beam ellipse parameters for each
of the three phase-space planes.  An example of the
resulting output from the Show Phase & Energy
command is shown in Figure 5-12.

Show TRACE 3-D Data

The Show TRACE 3-D Data ( -Option-P) command
displays the data that has been passed to TRACE 3-D
FORTRAN  from the PowerTrace Interface.  An
example of the output generated with this command is
given in Figure 5-14.  This data may require more lines
than can be displayed in the Text Output Window.
However, it is also written to the History file, as is all
data generated from commands that output text.

The Show Tape 30
command in the View
menu can be used to view
and edit this data.

TRACE 3D DATA:
  FILENAME: Example B  UNITS: mm, mrad, T/m, mA, MV/m
  ER= 1875.00000   Q= 1.   W=    2.00000   XI=  100.000
  EMITI=     60.0000     60.0000   1000.0000
  BEAMI =     3.1140     0.7536    -2.6202     0.5789     0.1210     0.5687
  BEAMCI=     0.0000     0.0000     0.0000     0.0000     0.0000     0.0000
  BEAMC =     0.0000     0.0000     0.0000     0.0000     0.0000     0.0000
  BEAMF =     0.0000     0.4154     0.0000     1.3289     0.0000     0.3570
  FREQ=   80.000,  PQEXT=  2.50, ICHROM= 0, IBS= 0 XC=  0.00
  XM= 17.9,  XPM= 58.4000,  YM= 21.4,  DPM=  0.,  DWM=    0.,  DPP=  57.
  N1=  1,  N2= 20,   SMAX=  5.0,  PQSMAX=  2.0
  NEL1 =   1,  NEL2 =  20,  NP1 =   1,  NP2 =  20
  MT=  8   NC=  4   LOC=   0   0   0
      MP(1,N)  MP(2,N)   VALUE        MVC      VALUE
         1        4     -23.44
         1        8      27.41
         1       12     -22.28
         1       16      24.76
     n  NT(n)   A(1,n)     A(2,n)     A(3,n)     A(4,n)     A(5,n)
     1   11    -0.7100   110.4000    86.4400   -28.7000     0.0000
     2   11     0.7100   110.4000    86.4400  -180.0000     0.0000
     3    1   173.0000
     4    3   -23.4441    96.0000     0.0000     0.0000     0.0000
     5    1    39.7500
     6   10     0.1815   -40.0000     0.0000     0.0000     1.0000
     7    1    39.7500
     8    3    27.4066    96.0000     0.0000     0.0000     0.0000
     9    1    42.7400
    10   10     0.1815   -40.0000     0.0000     0.0000     1.0000
    11    1    42.7400
    12    3   -22.2816    96.0000     0.0000     0.0000     0.0000
    13    1    45.7400
    14   10     0.1815   -40.0000     0.0000     0.0000     1.0000
    15    1    45.7400
    16    3    24.7586    96.0000     0.0000     0.0000     0.0000
    17    1    48.7300

Figure 5-14.  Output from the Show TRACE 3-D Data Command.
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Special PowerTrace Commands 

The last group of commands in the Commands menu
are unique to PowerTrace with the exception of the
PARMILA Units command which is described last.

Load Return Data

The Load Return Data (31→30) command loads the
data returned by TRACE 3-D (Tape 31) into the
PowerTrace interface data (Tape 30).  The “Data
Structures and Data Flow” subsection in Section 3 of
this manual describes the data flow between the
PowerTrace interface data and the TRACE 3-D
FORTRAN commons.  This command can be used to
force an update of the beamline model in the
PowerTrace Document from the current contents of the
TRACE 3-D FORTRAN  commons.  In some
circumstances TRACE 3-D will modify the data shared
with the PowerTrace interface, such as during a
matching procedure or when the Exchange Beams
command is used to move beams from a holding
position into the initial or final beam vectors.  This type
of update is automatically done by PowerTrace if the
“Auto Update After Match or Exchange” Option is
selected in the PowerTrace Options Dialog.  By default
this option is selected so that the beamline model will be
automatically updated after matching or a beam
exchange.  See Section 6 “User Preferences” for a
complete discussion of the PowerTrace User Options.

Reinitialize TRACE 3-D 

The Reinitialize TRACE 3D ( -E) command allows the
user to reinitialize all of the TRACE 3-D common
variables and arrays, while keeping all the model data in
the PowerTrace interface data structure.  This
command is also discussed at the end of the “Data
Structures and Data Flow” subsection in Section 3 of
this manual.

The Load Return Data
command can be used to
force an update of the
beamline model from the
t h e T R A C E 3 - D
FORTRAN commons.

The “Auto Update After
M a t c h o r E x c h a n g e ”
Option provides automatic
updates of the model after
m a t c h i n g o r b e a m
exchange.
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Help Submenu

The Help menu item has a submenu for five different
pages of help information.  Figure 5-15 shows the Help
Dialog for the first item: “General Input” which gives a
general description of TRACE 3-D parameters.  The
next three items present information on transport
element parameters and the last item diagrams beam
ellipse Twiss parameters.

Commands
Graph Beam Line
Trace on Background
Find Ellipses from Profile
Plot Projections
Calculate Phase Advance
Exchange Beams
Calculate Mismatch

Perform Matching
Match Without Print
Match in Range (MT=7,8,9)

Show Match Variables
Restore Prematch Variables

Show Beam Vectors
Show R Matrix
Show Modified Sigma
Show Phase & Energy
Show TRACE 3D Data

Load Return Data (31->30)
PARMILA Units
Help
Reinitialize TRACE 3D
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Show Match/Couple

Help General Input
Elements   1É  8
Elements   9É12
Elements 13É16
Twiss Parameters

General Input

Figure 5-15.  Help Submenu and TRACE 3-D Help Dialog Window.
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PARMILA Units

The PARMILA Units ( -Option-K) command will
cause TRACE 3-D  to write the PARMILA Data file.
This file will then be opened in a PowerTrace text
window.  The PARMILA Data file contains PARMILA
unnormalized input units and normalized output units
converted from the TRACE 3-D BEAMI, BEAMO,
EMITI, and EMITO parameters.  Figure 5-16 shows an
example of the PARMILA Data file generated with the
PARMILA Units command.

 PARMILA NORMALIZED RMS OUTPUT UNITS:  CM/MRAD CM*MRAD, DEG/MeV DEG*MeV
 BEAMO=   -0.058234    0.033608   -1.527421    0.260755   -1.336384  539.994026
 EMITO.RMS=    0.055440404    0.055440404    0.200000000
 EMITO.RMS.NORMALIZED.LONGITUDINAL(CM MRAD)=    0.111034407

 BEAM ENERGY=     2.000 MeV, TRACE3D TOTAL UNITS:
 TRANSVERSE UNNORMALIZED, MM/MRAD MM*MRAD; LONGITUDINAL NORMALIZED, DEG/KEV DEG*K
 BEAMI=    3.114000    0.753600   -2.620200    0.578900    0.121000    0.568700
 EMITI.3D-UNIFORM=     60.0000000     60.0000000   1000.0000000

 BEAM ENERGY=     2.000 MeV, TRACE3D TOTAL UNITS:
 TRANSVERSE UNNORMALIZED, MM/MRAD MM*MRAD; LONGITUDINAL NORMALIZED, DEG/KEV DEG*K
 BEAMO=   -0.058234    0.336079   -1.527421    2.607553   -1.336384    0.539994
 EMITO.3D-UNIFORM=     60.0000000     60.0000000   1000.0000000

Figure 5-16.  PARMILA Units Data File Display. 

A previously  generated file may be viewed using the
Show PARMILA Data command in the View menu.
However, the View menu command will not generate
the file and will be dimmed if the file does not exist in
the application folder.  When the PARMILA  Units
command is executed any existing PARMILA Data file
will be over written.

A previously  generated
file may be viewed using
the Show PARMILA Data
command in the View
menu.
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6.  User Preferences

This section discusses the remainder of the TRACE 3-D input parameters which
are primarily concerned with screen display options.  It also describes a number
of options available in PowerTrace, which the user can enable or disable to suit
particular requirements.  
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Preferences Menu 

The Preferences menu illustrated in Figure 6-1 is used
to access additional parameters which control plotting,
scale graphic output, specify centroid offsets, display
element parameters, and pass additional data to TRACE
3-D from the PowerTrace interface. The Preferences
menu also provides access the PowerTrace User Options
dialog.

Preferences

Plot Control NP & NEL
Graphics Parameters
Print Parameters
Extra Parameters
Centroid Parameters

Options

Figure 6-1.  PowerTrace Preferences Menu.

Plot Control Parameters

The first item in the Preferences menu opens the Plot
Control window shown in Figure 6-2.  This window
provides access to the TRACE  3-D plot control
parameters NP1, NP2, NEL1, and NEL2.  These
parameters are primarily associated with graphic output
from the Graph Beam Line, Trace on Background, and
Plot Projections commands.  NP1 and NP2 are the
beginning and ending locations for the beam profile
plot.  NEL1 and NEL2 are the locations for the first and
last ellipse plots.    

Figure 6-2.  Plot Control Window.

The Plot Control window may be used to view and
directly edit plot control parameters. However, these
parameters are automatically assigned by PowerTrace.

Refer to subheading 9.3
from Section 9 “Input
Variables” of the TRACE
3-D Documentation.

TRACE 3-D plot control
p a r a m e t e r s a r e
a u t o m a t i c a l l y s e t b y
PowerTrace using the
locations of the Initial and
Final Pieces in  the
beamline model.
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The default values for the Plot Control parameters are
the same as the default values used in TRACE 3-D.  The
graphics scales may be edited using these windows.
However, PowerTrace automatically generates scaled
values for these parameters when the user opens and
closes an “Initial” or “Final” element in a beamline
model.  A  discussion of the scaling equations is given in
using the locations of the Initial and Final Pieces in the
beamline model. This automatic assignment may be
turned off by disabling the “Auto update NP2 and
NEL2” option in the PowerTrace User Options dialog.
A complete discussion of all the user options is
presented later in this Section.  

Graphics Parameters

The Graphics Parameters item in the Preferences menu
opens two windows for the Initial and Final graphic
scaling parameters, as illustrated in Figure 6-3.  These
windows provide access to the TRACE  3-D graphics
scales  XM, XPM, DPP, YM, XMI, XPMI, DPMI, DWMI,
XMF, XPMF, DWMF, DPMF. These parameters set
values for the boundaries of the phase-space and profile
plots in the TRACE  3-D Graphic Output Window and
the plots in the Initial and Final Piece Windows.  XMI
(mm) and XPMI (mrad) are the axes for the initial
transverse phase-space plots.  DPMI (deg) and DWMI
(keV)  are the axes for the initial longitudinal phase-
space plots.  YM (mm) is the vertical axis for the
transverse beam profiles, and DPP (deg) is the
maximum phase profile.  XMF (mm) and XPMF (mrad)
are the axes for the final transverse phase-space plots.
DPMF (deg) and DWMF (keV) are the axes for the final
longitudinal phase-space plots.  XM (mm) and XPM
(mrad) are the axes for the projection phase-space plots.  

The graphics scales may be edited using these windows.
However, PowerTrace automatically generates scaled
values for these parameters when the user opens and
closes an “Initial” or “Final” element in a beamline
model.  A discussion of the scaling equations is given in 

“Auto update NP2 and
NEL2” is  on by default
but this option may be
disabled in the PowerTrace
User Options dialog.

Refer to subheading 9.5
from Section 9 “Input
Variables” of the TRACE
3-D Documentation.

Refer to subheading 9.5
from Section 9 “Input
Variables” of the TRACE
3-D Documentation.

PowerTrace automatically
generates scaled values for
graphics parameters when
the user opens and closes
an “Initial” or “Final”
element in a beamline
model.
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the “Initial and Final Beam Pieces” subsection of Section
3 in this manual.  This automatic graphics scaling may
be turned off by disabling the “Use Graphics Scaling”
option in the PowerTrace User Options dialog.  A
complete discussion of all the user options is presented
later in this Section.

Figure 6-3 Graphics Scales Windows.

Print Parameters

The Print Parameters item in the Preferences menu
opens the Print Parameters window shown  in  Figure
6-3.  This window provides access to the TRACE 3-D
print parameters NPRIN and IJPRIN.   These
parameters are used to specify up to ten transport
parameters to be displayed in the center of the Graphic
Output window when a Graph Beam Line or Trace on
Background command is executed.  The value of
NPRIN is the number of element parameters that will
be displayed.  IJPRIN is a two dimensional array which
is used to hold the parameter number and the sequence
of the element in the beamline model.  An example of
using print parameters is illustrated in Figures 6-4 and
6-5.  In Figure 6-4, the first and forth parameters of the
first and second elements in the beamline are to be
displayed.  In Figure 6-5, the results of a Graph
command are shown for the print parameter settings
shown in Figure 6-4.

“Use Graphics Scaling” is
on by default but this
option may be disabled in
the PowerTrace User
Options dialog to prevent
automatic graphics scaling.

Refer to subheading 9.6
from Section 9 “Input
Variables” of the TRACE
3-D Documentation.
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Figure 6-4.  Print Parameters Example.

All element parameters can
of course be accessed
directly in element Piece
Windows.

Print Parameters Specify 
Printout Values in the Graphic 

Output Window to Display 
Beamline Element Parameters

Figure 6-5.  Graph Command Output Using Print Parameters.
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Extra Parameters

The Extra Parameters item in the Preferences menu is
used to access the Extra Parameters window shown in
Figure 6-6.  This window is used to specify up to ten
additional parameters which will be passed through the
mixed language interface to TRACE 3-D and loaded
into the EXTRA array.  When customizing the TRACE
3-D FORTRAN, these parameters can provide access to
additional arguments not related to a particular
transport element.  The value of NEXTRA is the
number of EXTRA parameters that will be used.

Figure 6-6 Extra Parameters Window.

Centroid Parameters

The Centroid Parameters item in the Preferences menu
is used to access the Centroid Parameters window
shown in Figure 6-7.  This window is used to specify
initial beam centroid displacement values and a centroid
scale.  These parameters provide access to the TRACE
3-D initial beam centroid offsets: x (mm),  xÕ (mRad),
y (mm), yÕ (mRad), z (Deg), and zÕ (keV), which are
stored in the BEAMCI array.  The Show Beam Vectors
command, in the Commands menu, can be used to
display the contents of the initial beam centroid offsets
(BEAMCI) and beam centroid offsets (BEAMC) in the
Text Output window. The centroid scale (X C)
parameter is used in the profile plots for a displaced
beam centroid as seen in Figure 6-8.  If there is a
centroid offset and the scale is zero, then a  default scale

Refer to subheading 9.7
from Section 9 “Input
Variables” of the TRACE
3-D Documentation.

Refer to subheadings 9.2
and 9.5 from Section 9
“Input Variables” of the
T R A C E 3 - D
Documentation.
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of one-tenth the transverse beam profile is used.  The
value of the centroid scale is displayed in the profile
box at the bottom of the Graphics Output window.

Figure 6-7 Centroid Parameters Window.

Figure 6-8  “New Example C” Graph Command.

Figure 6-8 is the resulting output from a Graph Beam
Line command for the New Example C file distributed
on the application disk.  The beam centroid (BEAMC) is
shown in Figure 6-8 by the darker profiles.  The
horizontal (red) and the vertical (blue) profiles are
drawn with plus (+) symbols in the profile box.  

Refer to subheading 11.3
f r o m S e c t i o n 1 1
“Examples” of the TRACE
3-D Documentation.
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User Options

The Options menu item opens the PowerTrace User
Options Dialog illustrated in Figure 6-9.  User Options
can be used to control various PowerTrace and TRACE
3-D interactions.  The option selections shown in Figure
6-9 are the default selections.  Changes to the defaults
can be saved to a PowerTrace Preference file using the
Save As Default button.  Original defaults can be
recovered by discarding the PowerTrace Preference file
in the System Preferences folder.  If Save As Default is
not used, changes to option selections will be retained
until the application is terminated but will not be
written to the Preference file.  Options apply to all
PowerTrace Documents.

Figure 6-8 PowerTrace Default User Options.

Use Graphics Scaling

When the Use Graphics Scaling option is selected, the
ellipse plots in the Initial and Final Piece Windows will
be automatically scaled.  Graphics in the PowerTrace
Graphic Output Window will also be scaled
automatically.  If this option is not selected then no
scaling will be applied.  A discussion of graphics scaling

The Options item in the
Preferences menu opens
the PowerTrace User
Options Dialog which is
used to control various
PowerTrace and TRACE
3-D interactions.
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may be found in the “Initial and Final Beam Pieces”
subsection in Section 3 of this user manual.  The
graphic scaling parameters may be accessed using the
Graphics Parameters command in the Preferences menu
as described earlier in this Section.

Use Save Warnings

When the Use Save Warnings option is selected, a
warning alert will prompt the user to save the beamline
model any time a Document window is closed.  This is
illustrated in Figure 6-10 below.  If this option is not
selected then there will be no warning.

Figure 6-10.  Document Save Warning Alert.

The Save warning allows the close operation to be
canceled with the Cancel button, or the user may select
the Discard button which will cause the Document to be
closed without saving any changes.  If the OK button is
selected the Document will be saved and any existing
file of the same name will be overwritten.  To save the
Document under a different name, use the Save As…
command in the File menu.
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Use Warning on Reinitialize TRACE 3D

The Use Warning on Reinitialize TRACE 3D option
prompts the user when the Reinitialize TRACE 3D
command in the Commands menu is selected.  Since this
command will completely reinitialize the FORTRAN
commons in TRACE 3-D, an opportunity to cancel the
reinitialization is given if this option is selected,
otherwise no warning will be given.  As shown in
Figure 6-11, if the OK button is selected then the
TRACE 3-D  commons are reinitialized.  If the Cancel
button is selected then the Reinitialize TRACE 3D
command is not executed.  See the discussion of this
command in Section 3 in the “Data Structures and Data
Flow” subsection.

Figure 6-11.  Warning Before Reinitialization.

Use Pause During TRACE 3- Output

The Use Pause During TRACE 3-D Output option is
used to pause between pages of text output written to the
TRACE 3-D  Text Output Window.  If this option is
selected then the alert shown in Figure 6-12 will prompt
the user that text output has reached the bottom of the
Text Output window.  This provides an opportunity to
view the current contents before it is cleared.  The
Continue button must be pressed to resume execution.

Figure 6-12.  Pause Before Next Page.

After a command has
c o m p l e t e d , a n y d a t a
cleared from the Text
Output window can be
viewed using the Show
History File command in
the View menu.
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Auto Update From Tape30

The Auto Update From Tape30 option allows the user
to modify model parameters by editing the data in the
Tape 30 window.  If this option is not selected then
editing data in Tape 30 window will have no effect on
the model.  There are restrictions on the use of the Tape
30 edit feature.  Generally, any numerical parameter
may be changed using the Tape 30 edit option.
However, you may not add or delete beamline transport
elements this way.  

Auto Update After Match or Exchange

The Auto Update After Match or Exchange option,
when selected, will automatically update the model with
the data returned by the execution of any of the three
TRACE 3-D matching commands:  Perform Matching,
Match Without Print and Match in Range, or data
exchanged from the beam hold array into the Initial or
Final beam vectors.  This update is done internally in
TRACE 3-D, but the data flow used in PowerTrace is
such that the model data need not be immediately
updated. This update can be effectively turned off.  If
this option is not selected then the model Data Tables
are not modified after matching and the original data
remains in Tape 30 while the new (matched) data is in
Tape 31.  The user may select to update the model at his
leisure with the Load Return Data (31→30) option in
the Commands pull down menu.

Auto Update NP2 and NEL2

When the Auto Update NP2 and NEL2 option is
selected, PowerTrace automatically selects which
transport element (NP2) will be the last to be shown in
the profile plot, after executing the Graph Beam Line
command, as well as the element (NEL2) after which
the (output) phase space ellipses will be displayed.  This
automatic selection may be turned on or off with this
option.
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Warn Before Clearing History File

When the Warn Before Clearing History File option is
selected, an alert will be issued any time a command is
executed which will result in clearing the current
History file.  This is illustrated in Figure 6-13 below.

Figure 6-13.  Clear History File Alert.

Pressing the OK button will clear the History file and
execution will continue.  If the Cancel button is selected
then execution will continue without clearing the
History file.  This option can be used with the next  two
options: “Auto Clear History File Before Run” and the
“Save History Changes on Window Close” to better
manage the content of the History file.  Note that the
History file will hold up to 32K characters, but after
reaching this limit data will be lost.

Auto Clear History File Before Run

The Auto Clear History File Before Run option will
cause the History file to be deleted prior to executing
any command which writes to the History File.  The
“Save History Changes on Window Close” option will
save any editing done in the History file when the
window is closed.  This can be useful to manage
content, add comments, or paste any other information
copied from other text windows. The History file is
discussed further in Section 5 “TRACE  3-D
Commands”.  
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Generate Aperture File

When the Generate Aperture File option is selected, the
Half-Aperture/Profile value field is also provided in the
options dialog to set the TRACE 3-D aperture
multiplication factor.  As illustrated in Figure 6-14, the
PowerTrace default options include the Generate
Aperture  Data selection with a  1.0 Half-
Aperture/Profile value.

When  the Generate Aperture File Option is 
Selected, the Half-Aperture/Profile Field is 
Activated and it's value is used to set the 

TRACE 3-D Aperture Multiplication Factor

Figure 6-14.  PowerTrace User Options Dialog.

If the Generate Aperture Data option is selected in the
PowerTrace User Options dialog then aperture data will
be written during the execution of the Graph Beam Line
or Trace on Background commands.  When either of
these commands is executed any existing Aperture Data
file will be overwritten.  The Aperture Data file can be
opened using the Show Aperture Data command in the
View menu.  This command will be dimmed if the file
does not exist in the application folder.  

Aperture data will also be
written when the Find
Ellipses from Profile,
C a l c u l a t e M i s m a t c h ,
Perform Matching, Match
Without Print and Match in
Range commands are
executed.
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The aperture data contains the transverse beam profile
data (radial x- and y-profiles) that is used to generate
the beam profiles in the Graphic Output Window with
the Graph Beam Line or Trace on Background
commands.  Figure 6-15 shows the Aperture Data
generated during a Graph Beam Line execution for
Example B.

PowerTrace     11-08-1997     21:22:31
 TRACE-3D PROFILES/APERTURE DATA (Aperture Multiplication Factor=      1.000000)
 (all units =  mm)
 Values at Point of Maximum Beam Extent:
                                                  Factor*  Factor*  Circular
  TRACE        Radial   Radial                    Profile  Profile  Beampipe
 Element      Profile  Profile   Center   Center  +Center  +Center   radius
   No.           X        Y        X        Y        X        Y         R

    1  RFQ      5.48     7.17     0.00     0.00     5.48     7.17     9.03
    2  RFQ      7.19     5.47     0.00     0.00     7.19     5.47     9.04
    3  Drft     3.06    11.33     0.00     0.00     3.06    11.33    11.74
    4  Quad     2.92    11.95     0.00     0.00     2.92    11.95    12.30
    5  Drft     4.15     9.69     0.00     0.00     4.15     9.69    10.54
    6  RF g     4.15     9.69     0.00     0.00     4.15     9.69    10.54
    7  Drft     5.48     7.31     0.00     0.00     5.48     7.31     9.14
    8  Quad     7.78     3.92     0.00     0.00     7.78     3.92     8.71
    9  Drft     7.50     2.49     0.00     0.00     7.50     2.49     7.90
   10  RF g     7.50     2.49     0.00     0.00     7.50     2.49     7.90
   11  Drft     6.58     2.51     0.00     0.00     6.58     2.51     7.04
   12  Quad     7.48     3.86     0.00     0.00     7.48     3.86     8.42
   13  Drft     9.70     3.90     0.00     0.00     9.70     3.90    10.45
   14  RF g     9.70     3.90     0.00     0.00     9.70     3.90    10.45
   15  Drft    12.24     4.23     0.00     0.00    12.24     4.23    12.95
   16  Quad    13.48     5.76     0.00     0.00    13.48     5.76    14.66
   17  Drft    11.94     7.78     0.00     0.00    11.94     7.78    14.25
   18  RF g    11.94     7.78     0.00     0.00    11.94     7.78    14.25
   19  Drft     7.07    13.95     0.00     0.00     7.07    13.95    15.64
   20  Quad     5.45    15.81     0.00     0.00     5.45    15.81    16.72

 MAX VALUES:   13.48    15.81     0.00     0.00    13.48    15.81    16.72

 VALUES ON ABOVE RUN:  I=   100.0mA   W(in)=   2.0000  W(out)=   2.0000MeV
      EMITi=  60.000   60.000  1000.00,   EMITo=  60.000   60.000  1000.00

 Minimum Beampipe Radius Required
 (Factor=  1.000)  R=   16.72 mm

Figure 6-15.  Aperture Data File.
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